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Important!
This mini version is basically a stripped down version of the full featured registered version of CASINO 
PLANNER for Craps.    With this mini version, you will be able to "test drive" the software for yourself to 
see how practical CASINO PLANNER is for planning a winning trip to the casino.    This mini version has 
the Game Mode in its entirety.    However in the StrategyMaster Mode, ONLY the Pass Line and Place 4 
& Place 10 bets are FULLY functional.    Use these bets to learn how to use    StrategyMaster (i.e. Money 
Management, Money Management Assistant, and results such as Fundamental Five, Highs and Lows, 
Averages and Totals, etc.).    Once you have experience using StrategyMaster on the Pass Line, you will 
then be ready to use other bets in conjunction with more complex Betting Strategies.    

See the Order menu for information on how to order the full featured registered 
version.



Why CASINO PLANNER?
Casino Entertainment
What You Don't Know can Hurt You
Fighting Fire with Fire
A Much More Reliable Way to Win
Winning 100% of the Time
90% WinRating
Answers in the Matter of Minutes!
Prepare and Compare



Casino Entertainment
Today, more and more Americans are looking for new forms of entertainment and gaming has become the 
popular choice for recreation and fun in the 90's.    Gaming has become so popular that more people are 
visiting casinos than baseball stadiums and there are many good reasons why.    Casinos offer exciting 
games, luxurious rooms, grand buffets, fine dining, elegant decor, courteous personal and the best in live 
entertainment.    But there is more to gaming than meets the eye.



What You Don't Know can Hurt You
For a typical night out on the town you generally know how much you can expect to spend for the evening. 
With gaming this is not necessarily true.    People can easily get caught up in the excitement of gaming and 
find themselves spending far more than they ever expected.    It is not uncommon for a player to leave the 
casino with ALL his play money lost, and sometimes owing additional money in markers taken out at the 
table or in cash advances on credit cards.    This happens most frequently when a player is not prepared 
AND does not know what to expect.    They may rely on Lady Luck or the throw of the dice for an elusive 
chance of winning.    You do not have to depend on luck to win.    With a bit of preparation you can even 
have a better than 50% chance of coming home a winner from the casino.    

Let's say you've just made reservations to go on a trip to the casino.    Now what do you do?    How do you 
prepare for your trip?    Do you know all the rules of the game?    What betting strategy should you use?    
How much money should you bring?    How much Playtime can you expect?    These are some practical 
questions that should cross your mind when you're getting ready to go to the casino.    CASINO PLANNER 
has been designed expressly for this purpose.

DEFINITION:    Casino Planner.    An interactive multimedia game AND powerful 
planning tool that has unique features to teach you how to dramatically increase your 
chances of winning at a real casino.



Fighting Fire with Fire
It's you against the casino.    Playing against the House can be like going to war.    Even though the casino 
will eventually win the war, you can win a majority of the battles.    However, at the end of each battle the 
victor does not gain land like in the traditional sense, rather the victor wins hard cash -- definitely 
something worth battling for!    In our case, the crap table is the battlefield; you are a general and the 
casino is the opposing general.

Just like in a real battle, both sides must prepare for inevitable duel that is about to take place.    But how 
does the casino prepare?    The casino does not rely on luck to win and neither should you.    Their plan is 
based on simple probability of the dice.    In a similar manner, you can use probability to your advantage by 
using a well conceived Betting Strategy.    Now you can be on an even playing field with the casino and 
thus dramatically increase your chances of winning.    There's nothing complicated about it.    It's all very 
simple and all you need is CASINO PLANNER.



A Much More Reliable Way to Win 
Don't depend on luck because it will probably be BAD!    Bad luck is the reason most people give when 
they lose.    Many players have incredible strings of GOOD luck, yet still walk away from the table losing 
money.    An exclusive feature of CASINO PLANNER called StrategyMaster™, provides a much more 
reliable way to win.    Using the information provided by StrategyMaster, you can accurately predict how 
your strategy will perform in "real-world" situations.    But isn't craps based on random chance and luck?    
How could we possibly know in advance what will happen?    The answer may surprise you.    Though we 
can not know with absolute certainty what will happen in the future, we can have an accurate expectation of
what will happen.

Take a simple coin toss as an example.    Though you don't know what the next flip of the coin will be, the 
laws of probability will determine how many times "heads" or "tails" will come up (i.e. 50% for both).    
StrategyMaster uses probability to accurately predict how your strategy will perform before stepping up to
the tables.    With    StrategyMaster you don't have to depend on luck anymore.



Winning 100% of the Time
Let's say you and a friend are going to gamble against each other and the name of the game you are going 
to play is called "Coin Flipping".    The rules are simple.    If heads shows you win a dollar, and if tails 
shows your friend wins a dollar.    It is possible to beat your friend 100% of the time as long as you are the 
one who determines when the game (or session) is over.    The rules of Probability say that if you keep 
playing against your friend, eventually heads will come up more often than tails, and when it does, you tell 
your friend the game is over -- you win!

A lot of people think that since heads has a 50% chance of showing, that your chances of winning are also 
50%.    THIS IS NOT TRUE!    Don't confuse the two numbers.    It's true that the chances of heads showing 
is 50%, however, your chances of winning can be as high as 100%, if you determine when the game is over.
In other words,    your chances of winning is NOT the same as the chances of    heads showing.

For all practical purposes, casino games are a lot like coin flipping, as far as your chances of winning are 
concerned.    Basically, casino games offer a slightly less than 50% chance for you to win.    And since you, 
and NOT the casino, determine when to walk away from the table, you can likewise beat the casino a 
majority of the time.    

CASINO PLANNER has an exclusive feature called the WinRating that makes it easier than ever for you to
know when to walk away from the table a winner AND with the amount of money you want to win.    Since
casinos have a slight advantage, you can not win 100% of the time like in coin flipping, but you can have 
WinRatings around 90%.



90% WinRating
Even though it is easy for you to win more than 50% of the time, the casinos will still make their profits.    
Let's look at a simple example which will illustrate how it is possible to have a WinRating of 90%.    For 
this example, your Betting Strategy will play each session that risks $1,000 (bankroll) to win $100 (win 
goal).    Let's say the first session won $100 while risking $1000.    The second session won $100 while still 
risking $1000.    You win $100 for nine consecutive sessions at the table and each time you never lost your 
$1000 bankroll.    However, on the tenth session, you lost $1000 before you could reach your $100 win 
goal.    Therefore, you had a WinRating of 90% (i.e. won 9 out of 10 sessions) and the casino still made its 
profit of $100.    You can win a majority of the battles (i.e. sessions), but the casinos will always win the 
war.

Session # Won/Loss

1 $100

2 $100

3 $100

4 $100

5 $100

6 $100

7 $100

8 $100

9 $100

10 -$1,000

Net = -$100 down

Answers in the Matter of Minutes!
CASINO PLANNER provides a new approach to casino entertainment.    CASINO PLANNER is an 
interactive multimedia game and  powerful planning tool.    This software marks the beginning of a new era 
in casino gaming in which players can use their    personal computer to prepare for a trip to the casino and 
thus dramatically increase their chances of winning at a real casino. 

CASINO PLANNER takes advantage of the computational power of your personal computer to help you 
master the game of craps.    You can plan for a winning trip to the casino by first trying out your crap 
strategies at home without risking your hard-earned money.    This is accomplished by the APPLICATION 
abilities of StrategyMaster.

The basic concept behind StrategyMaster is very simple.    You enter the crap strategy that you are 
interested in through a convenient window, then in the matter of minutes you are provided a wide range 
of important information about your strategy.    Until now, the school of hard knocks at the casino was the 
only real proving ground to try out your ideas and strategies.    CASINO PLANNER has changed all this.    



Prepare and Compare
These are the two words that set CASINO PLANNER apart from all other software.

Prepare
 "It is better to be smart

than lucky!"
Being smart simply means being prepared.    CASINO PLANNER is a program that is specifically designed
to prepare you for a winning trip to the casino using exclusive features not found in any other software.    
CASINO PLANNER helps you plan for your trip by providing answers to ten of the toughest questions 
about your strategy.

1. What are the advantages and disadvantages of your strategy?
2. What are your chances of winning are in terms of percent?    (i.e. WinRating™)
3. How do you determine a realistic Win Goal?
4. What the chances are of reaching your Win Goal?    (i.e. WinGoal Rating™)
5. What kind of bankroll is needed to play your strategy?
6. How much time can you expect to play your strategy?
7. What is the expected "cost per hour" to play your strategy?    (i.e. entertainment value)
8. What the House Advantage is for your entire strategy?    (i.e. VigRating™)
9. How do you get WinRatings of greater than 50%?
10. When is the best time to stop playing to maximize your winnings?    (Most players stop playing 

when they've lost all their money.    Needless to say, this is the worst time to stop playing. But when
is the best time?)

Ironically, most players don't know the answers to these questions, yet they want to win.    Only CASINO 
PLANNER addresses all these questions so you can truly be prepared to win.    On the contrary, if you are 
not prepared, the cost of your entertainment can easily be far greater than what you expected.    

Prepare with CASINO PLANNER and gain experience and knowledge that would normally take a lifetime 
to acquire.    You'll get hands-on experience using different strategies.    The casino is not the place to learn 
how to play or try out your strategies.    The pros can tell you this.    Most have probably lost thousands or 
even tens of thousands of dollars in order to acquire all their experience and know-how.    This kind of 
experience costs money and lots of it.    But now with CASINO PLANNER, there is an easier way to gain 
this valuable insight.    Then, each time you go to the casino you'll get the most from your entertainment 
dollars.    Remember,

The Best Strategy for Winning is PREPARATION!

Compare
A very important part of preparing for your session at the table is choosing the strategy that is right for you. 
You do that by comparing different crap strategies.    There are literally thousands of crap strategies.    Using
CASINO PLANNER, you can objectively compare crap strategies quickly and easily -- all in the matter of 
minutes.    Just sit back and relax while the software runs countless "what if" scenarios to give you a clear, 
overall picture of just how any strategy will perform in "real-world" situations.    With the results provided 
by StrategyMaster, you can determine for yourself the advantages and disadvantages for the strategies that 
you are interested in. 



Learning with Interactive Multimedia
Interactive multimedia is rewriting the book on the way people learn.    Two significant facts about 
interactive multimedia:

1. Interactive multimedia allows you to simulate what you cannot otherwise do.
2.    Interactive multimedia affords you the opportunity to improve your performance and capability. 

A person will typically remember:
· about 10% if they read it.
· about 20% if they hear it.
· about 30% if they see visuals related to what they're hearing.
· about 50% if they watch someone do something while explaining it.
· about 90% if they do it themselves -- even if it's a simulation.

A good application of this technology is in learning how to play the game of craps.    A lot of people would 
like to play craps but are intimidated by the learning process.  CASINO PLANNER for Craps is an 
interactive multimedia game/application that makes it easier than ever to master the game of craps.

Related Topics:
Learning to Play
Playing to Win



Learning to Play
If you've never played craps before, you may be surprised to learn that it's really a very simple game.    
Many people will walk up to the table, watch the seemingly complicated action for a while and then walk 
away  because it looks so intimidating.    In reality, the rules of craps are very simple.

Hands-on experience is the best way to learn a new game.    If you're like most people, you learn faster by 
doing.    CASINO PLANNER brings the sights and sounds of a real casino into your living room.    If you're
a beginner, the "Craps Tutor" will teach you how to play and walk you through the basics of the game at 
your own pace in the privacy of your    home.    You will be  playing in no time -- even if you've never even 
seen the game before.    Then you will gain experience by practicing at the IGS crap table.



Playing to Win
Knowing how to play DOES NOT mean you know how to win.    The key to winning is to having a well 
planned strategy.    A strategy is simply a session at the table in which you have everything planned out from
the time you  purchase your chips to the time you leave the table.

A strategy has two basic parts:
1. Money Management.    Your starting bankroll, win goal, loss limit and time limit.
2. Betting Strategy. When to make each bet and for how much.

StrategyMaster provides a wide range of important information such as the Fundamental Five™, Highs and
Lows, Averages and Totals to help dramatically increase your chances of winning at a real casino.



Inside the IGS "Casino"
The IGS Casino has all the sights and sounds of a real casino.    Bets can be heard as they are placed and 
taken away.    You can hear the dice being rolled as the shooter throws them across the table.    You can 
listen as the stickman calls the outcome of each roll.    In a real casino you can hear music playing in the 
background, the same is true    inside the IGS Casino.    You can even hear crowd sounds and slot machines 
in the background to experience  the feel of a real casino!

Look at the IGS crap table.    Notice that when you move the mouse over the table,    the pointer    appears as
a "hand".    Whenever the pointer is a    hand you can click with the left mouse button to place bets and roll 
the dice.    When the pointer becomes an arrow, you are near a control button or menu option.    You can 
choose any control or menu option by clicking on it with the left mouse button.

Related Topics:
Crap Table
Unlabeled Bets on the Table
Benefits of the Gray Table
Instant Help on All Crap Bets



Crap Table
The IGS crap table has the authentic layout of a real casino crap table.    However, only one half of the IGS 
crap table is visible since the other half is a mirror image of the first half.    Also, you will see how to play at
the crap table with other animated players -- each with their own personality.

RECOMMENDATION:    If the IGS crap table colors look a little dark, adjust the 
brightness knob on your monitor appropriately.    Also, 256 colors will look much better 
than 16 colors. 



Unlabeled Bets on the Table
Unfortunately, a real crap table only has some of the bets labeled with text on the layout.    Bets that don't 
have text    include, Place bets, Buy bets, Lay bets, Come and associated Free Odds bet, as well as, Don't 
Come bets and associated Free Odds bets.    That's seven type of bets with that do not have a label on a real 
crap layout.    For the IGS crap table, the following diagram shows areas where to click with the mouse 
button to make various bets that are not labeled on the table.

For a given bet type, only one example was given in the table.    For example, there are six different Place 
bets on the Table (i.e. Place 4, 5, 6, 8, 9 and 10).    Only the area where to make a Place 10 is shown in the 
above diagram, other Place bets are made in a similar manner.    Notice the Place bet area covers the left 
most 50% area of where the 10 is marked on the table.    The right most 50% area is for the Buy 10 bet.    
The other 5 numbers (i.e. 4, 5, 6, 8 and 9) follow the same convention for Place and Buy bets.    The gray 
crap table distinguishes the "unlabeled" bets by using two different shades of gray. 



Benefits of the Gray Table
From the Options menu, choose Casino.    In the lower left side of the dialog, select the gray table and 
click OK.    Now you will see a gray crap table.    Notice there are light gray and dark gray areas on the 
layout.    These different shadings of gray distinguish unlabeled bets and show    where one bet area starts 
and another begins.    Placing unlabeled bets is therefore more intuitive with the gray table.    Also, the gray 
table makes it easier to see the colored chips resting on the table.    For these reasons, you may want to    
play with the gray table most of the time. 



Instant Help on All Crap Bets
There are times when you are interested in the certain aspects of a particular bet (i.e. you forgot payoff 
odds).    Help for all the bets on the IGS crap table is just a mouse click away.    

RECOMMENDATION:    Hold down the SHIFT key and click with the left mouse button
on the IGS crap table for instant On-line Help for the bet you are interested in.

Help information on a specific crap bet includes definition, true odds, payoff odds, house advantage, 
decision, and vigorish.    When you are done with the help, go to the File menu and choose Exit.

RECOMMENDATION:    While using the On-line Help, hold the ALT key and then press
the TAB key to "toggle" you back and forth between On-line Help and the IGS crap table.



Control Panel
The Control Panel occupies the entire lower portion below the IGS crap table.    It contains control and 
status information while using CASINO PLANNER.    The following is a description each of the items in 
the control panel.

{ewc D2HTools, D2H_256Color, help0003.bmp}

Your Chips
In a casino, chips    are used in place of cash to make bets.    Slots around the top edge of the table called 
rails are used to hold the chips for each player.    Look just below the IGS crap table at the left side area of 
the screen and you will see your chips.    They come in different colors just like in a real casino.    Each chip 
color is worth a certain amount of money.    Chip colors are commonly defined as follows: White = $1, Red 
= $5, Green = $25, Black = $100, Pink = $500.    These chips represent your bankroll.

(Note: You can have a bankroll that exceeds $5000, however no more than $5000 in chips will be shown.)

Bankroll Rail
DEFINITION:    Bankroll Rail.    The place where your playing chips are kept 
for future bets.    

Bankroll Amount - This is the dollar amount of your chips and is shown below the Bankroll Rail.

Bet Rail
DEFINITION:    Bet Rail.    The place where you "assemble" a bet amount before 
placing it on the IGS crap table.

Chips are taken out of the Bankroll Rail and assembled in the Bet Rail.    Once the proper bet amount is 
assembled, it is ready to be placed on the IGS crap table.    The money assembled in the Bet Rail will be 
placed on the table when you click with the left mouse button over the area of the table where you want to 
make a bet.    In other words, if the Bet Rail contained a green chip and you clicked the FIELD bet area of 
the table with the left mouse button, you would see a green chip appear on the table.

Bet Rail Amount - This is the dollar amount of the chips and is shown below the Bet Rail.

Marker
There are times when you are playing craps and you do not have sufficient bankroll to make another bet.    
In this case you can click on the word "bankroll".    This will bring up the "Marker" window which allows 
you to "borrow" money to keep playing.    (Note: no strategies should require taking markers above and 
beyond your initial bankroll, but since players do take markers when they run out of money, CASINO 
PLANNER also allows you to do this.    However, this is not a wise move and we advise you to play with 
strategies that do not require markers.

Roll Results



Just below the word "Bankroll" in the control panel is a status box.    This Status Box keeps you informed as
to what happens to your money after each roll.    Just after the dice are rolled, the status box will cycle 
through five results: 

1. Lost - Total money lost from the current roll.

2. Won - Total money won from the current roll

3. Net - Sum of money won and lost for the current roll

4. Total - Sum of current bankroll amount in the bankroll rail and all bets on the table
(In other words, the total amount of money you have on and off the table.)

5. Ses Net - Cumulative total of all money won or lost from the start of your session

You can adjust the rate at which CASINO PLANNER cycles through these five numbers.    To do this, go to
the Options menu and select General.    If you are interested in the "roll results" and want to read them as 
the five cycled numbers then adjust the slide bar to the left to a slow setting.    If you are not interested in 
the "roll results" then adjust the slide bar all the way to the right so as not to slow down your game.

On Table

The text in the control panel that says "On table shows the amount of all bets currently on the table.

Dice Roll Graph

The graph below the text "Dice Rolls on the control panel shows the relative number of times each dice 
number was rolled during the game.    There are 11 tick marks at the bottom of the graph which represent all
dice roll combinations 2-12.    The left most tick mark represents the number of times the number 2 was 
rolled, and the right most represents the number of times the number 12 was rolled.    As the game is played 
you should see the graph start to take the shape of a bell curve.    The bars can be two colors.    Black 
indicates that the dice accuracy for that number is within 5% of ideal number, if the color is blue the 
number is not.    

It is interesting to note that you win more often when the bell curve deviates from the ideal bell curve.    On 
the contrary, if the dice accuracy matches the ideal bell curve you will lose more often.

Roll Dice Button

Use this button  to randomly roll the dice.    This button can be used in both the Game Mode 
and StrategyMaster Mode.

Auto Roll Button

Use this button  to have the dice rolled automatically by CASINO PLANNER in a random manner    



After you click the "Auto Roll" button, it will turn into a "Stop" button.    Click the "Stop" button to end "Auto Roll".
This button can be used in both the Game Mode and StrategyMaster Mode.

Run Button

Use this button  to run a system that is entered into StrategyMaster through a dialog box 
interface.    StrategyMaster will run as fast as your computer will allow in order to give you vital 
information contained in StrategyMaster results window.    From the Options menu, choose 
StrategyMaster.    This dialog box contains the "number of sessions" that StrategyMaster will run.    A 
larger number of sessions will take StrategyMaster longer to run, but the results window will contain more 
accurate information.

This button is a short cut for the menu selection "StrategyMaster/Run/Go    This button can only be used 
in the StrategyMaster Mode and cannot be used in the Game Mode.    

Reset Button

Use this button  to reinitialize the current session    In the StrategyMaster Mode, this    button is 
a shortcut for the menu selection "StrategyMaster/Run/Reset".    This button can be used in both Game 
Mode and StrategyMaster Mode.

Betting Strategy Button

Use this button  to take you to the dialog box where you can enter in the bets for your strategy. 
This button is a shortcut for the menu selection "StrategyMaster...Setup Strategy...Bets".    This button can 
only be used in the StrategyMaster Mode and cannot be used in the Game Mode.    

Time
The text in the control panel that says "Time"  shows the amount of time that has been played at 
the table with respect to the number of rolls of the dice.

In a real casino you do not control when the dice are rolled, the stickman does.    On average, the dice are 
rolled about every 30 seconds, or 120 rolls per hour.    Under the Options menu, choose Casino.    The 
default for the "Rolls per hour" is 120.    Therefore, if there were 30 rolls of the dice, this would mean the 
Control Panel "Time:" would show 0 hr 15m.    In other words, if you were at a real casino, you would have
been playing for about 15 minutes.

Mode
The text in the Control Panel that says "Game Mode" or "StrategyMaster Mode" shows the current mode of
CASINO PLANNER.    From the Options menu, choose Mode to change setting.

Bet Amount and Type
Just to the right of the text in the control panel that displays the mode is a status box which helps you when 
betting on the crap table.    As you move the curser over the table, this status box

 indicates the bet amount and bet type under the curser.

Dealer Captions
Just to the right of the text in the control panel that says "Shooter" is a status box which helps you follow 



the action during the game.    Captions    describe what is happening here at all times.

Hot/Cold Table IndicatorHot/Cold indicator
Just to the right of the IGS crap table is a 
thermometer.    This "thermometer" shows 
how "hot" or how "cold" the table is, based 
on what has been happening on the Pass Line.
Use this to vary your strategy for "hot 
streaks" or "cold" conditions at the table.    
This thermometer tracks what has been 
happening at the table for the last 30 
simulated minutes.

Player Animation

The Player Animation is a second view of the IGS crap table located in the lower right hand corner of the 
main screen.    This is the same view that the boxman has as he looks across the table toward the players 
(one of which is yourself).    

The purpose of the Player Animation is to allow you to see up to 3 animated players and stickmen as the 
game is played.    You can control how many players appear in the Player Animation and you can also 
decide which one of these players will be "you".    The options for the Player Animation include: 

1.    From the Options menu, choose General.    

a. In this dialog, you will see text "Player Animation".    If the check box next this text is active 
then animated players and a stickman will be shown at the IGS crap table.

b. In this dialog, you will also see text "Number of Players".    If you select "I am the only player" 
then only you and the stickman will be shown in the Player Animation view.    If you select    
"Three players at table", then three players and the stickman will be displayed in the Player 
Animation view.    Even though there can be three players, you are the only one that can make 
bets on the table.    However, the dice are passed from player to player each time there is a new 
shooter.

2.    From the Options menu, choose Select Players.    

In this dialog box you can select from 12 different players to represent yourself.    Each of the 12 
players has their own mannerisms and personality.    Suzy even smokes a cigarette, while others sip 
their drinks.    When there are three players at the table the other two players are selected randomly by 
CASINO PLANNER.    

In the Player Animation, you can watch the shooter roll the dice.    The shooter will shake the dice and 
then throw them across the table.    This happens at the same time the dice are moving across the IGS 
crap table at the top part of the screen.    When the dice come to rest, the stickman will collect the dice 
and hold them.    The stickman will put the dice in front of the shooter only after all bets have been 



either collected or paid off, just like in a real casino.



Introduction
When using CASINO PLANNER, you can be in one of two modes -- Game Mode or StrategyMaster 
Mode.    You can change from one mode to the other at any time, but this will cause a reset.    From the 
Options menu, select Mode to change setting.    The current mode of CASINO PLANNER is always 
displayed in the Control Panel located below the IGS crap table.

Game Mode
DEFINITION:    Game Mode.    All bets must be made manually, one roll at a time, just 
like you would in a real casino

This mode allows you to practice playing a strategy after you have found one you liked from the 
StrategyMaster mode.    Therefore, you can play on your own as if you were at a real crap table for the 
benefit of preparing for a trip to a real casino.

StrategyMaster Mode
DEFINITION:    StrategyMaster Mode.    All bets are made automatically according to a 
predefined Betting Strategy that has been entered through the convenient "Make A Bet" 
window.

In the StrategyMaster Mode,    CASINO PLANNER will automatically make ALL your bets as defined by a
Betting Strategy that is saved in memory.    StrategyMaster can simulate up to 20,000 consecutive sessions 
in a short period of time.    After a simulation is completed, StrategyMaster will tally the results and provide
you a wide range of important information about your Strategy.    With this information you will be able to 
"fine tune" your Strategy for optimum performance (i.e. WinRating, Playtime, cost, etc.), or objectively 
compare it to other strategies.



Game Mode
How to Setup the Game Mode
Game Mode Options
How to Make a Bet
How to Remove a Bet
How to Roll the Dice
Winning and Losing
Comeout Roll
Point Roll
Using "Auto Correct Bet Amounts
Using the Reset Button
How to Speed Up the Pace of the game
Wrapping Up



How to Setup the Game Mode
1.    From the Options menu, choose Mode.    A dialog box titled "Mode" will appear as shown below.    

Select Game Mode and type in a Starting Bankroll of 1000.    Click OK.    This will take you back to 
the IGS crap table.
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Game Mode Options
1. From the Options menu, choose General

a. Locate the "Animation Settings" box.    Here you will see a check box called "Single step 
though results".    If this check box is active then    your losing bets will be removed from the 
table first, one bet at a time, and then your winning bets will be paid off, one bet at a time - just
like a real casino.    If this check box is not active then all losing bets will be removed and all 
winning bets will be paid off at the same exact time.    Not activating this check box will 
significantly speed up the pace of the game.

Unlike a real casino, with CASINO PLANNER you can control the speed of the action at the 
table.    To do this, there are two slide bars that control the pace of the game.    

The slide bar called "Roll results" controls how fast CASINO PLANNER will cycle through 
the five roll results in the control panel.    If you are interested in reading these five results after 
each dice roll then you will want to select a long delay for this slide bar.    Otherwise, you will 
want this slide bar to be set at a slow delay of    0.1.

The slide bar called "Between rolls" controls how fast CASINO PLANNER will roll the dice 
when Auto Roll button has been clicked.    Normally you will want this slide bar to be set at the
shortest delay of 1.    However, if you want to simulate a real casino which rolls the dice 
approximately every 30 seconds, you have this ability.

b. Locate "Player Animation".    If this check box is active, animated players will be seen at the 
table in the lower left portion of the main screen, otherwise, no players will be shown.    It 
should be noted that if "Player Animation" is selected, the pace of the game will slow down 
due to the animation of the players.

c. Locate "Auto correct the bet amounts" box.    Certain bets on the IGS crap table need to be 
made discretely incremental amounts.    For example, the Place 6 bet must be in increments of 
$6.    Let's say the Bet Rail contained $7 and you clicked the mouse to make a Place 6 bet.    If 
"Correct without prompts" is selected then $7 from the Bet Rail would automatically adjust the
$7 to $6.    If "Correct with prompts" is selected then a message box would prompt you for a 
correct bet amount.

2. From the Options menu, choose Casino.    Remember that CASINO PLANNER is specifically 
designed to prepare you for a winning trip to the casino.    Part of preparing means practicing your 
strategy with the same payoff odds as the casino you are planning to visit.    The "Setup Casino" dialog 
box allows you to set up all of the rules and payoff odds to match the real casino that you are about to 
play. 
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CASINO PLANNER already has preloaded some of the more popular casinos in the United States.    
These casinos already have been setup with proper rules and payoffs.    If the casino you are going to 
visit is not listed, you may click the "new" button and add new casinos to the list.    If you do not know 
the payoff odds, you can call the casino and ask them to send you their "Gaming Guide" in the mail.

3. From the Options menu, choose Sound Options.    While playing in the Game mode you can select up
to four sound options.    (Note: Must have sound card for this option.) 
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a. Speech - This option enables or disables the stickman calling the game.

b. Sound Effects - These include dice sounds, sound of bet being removed from table, If your 
you lose on a given dice roll you will hear a cash register sound (sale), if you win on a given 
dice roll you will hear multiple chips being placed in the Bankroll Rail.

c. Crowd Sounds - In a real casino you will hear background sounds as you play, likewise 
CASINO PLANNER allows for this sense of realism as well.

d. Music - In a real casino you can hear music playing from the ceilings above, likewise CASINO
PLANNER allows you to enjoy soothing MIDI music as you play, or by turning this option off 
you can load and play your favorite CD!



How to Make a Bet
To make a bet in a real casino you would take chips out of your bankroll, assembling them in your hand, 
until you have the amount you want.    Then you would put those chips on the table.    This method is very 
similar with CASINO PLANNER except that you must use the bet rail, not your hand, to assemble your bet
before putting it on the table. 

How to take chips out of your Bankroll Rail and assemble them in the Bet Rail:

1. To add chips to the Bet Rail, use the left mouse button and click on the chip color in the Bankroll Rail 
that you would like to add to the Bet Rail.    Each time you click the mouse on a chip color, it will be 
added to the Bet Rail.

2. To remove a chip from the Bet Rail, use the right mouse button and click on the chip color in the 
Bankroll Rail that you would like to remove from the Bet Rail.    Each time you click the mouse on a 
chip color in the Bankroll Rail, it will be removed from the Bet Rail.

3. To remove all chips from the Bet Rail, use the left or right mouse button and click anywhere in the 
empty space just to the right of the chips in the Bankroll Rail. 

4. An alternate way to assemble a bet in the Bet Rail is to highlight the Bet Rail amount which is 
represented by a number and directly type in the bet amount desired, then hit the TAB key.

For example, let's make a $25 Pass Line bet.

5. Make a $25 "Pass Line" bet by moving the cursor (hand)    so that the "index finger" is over the upper 
50% of the Pass Line area on the table and click with the left mouse button.    You now have a $25 Pass 
Line bet on the table.

Use this same procedure to make bets anywhere on the IGS crap table.

RULE:    Use the left mouse button to manually make a bet on the IGS 
crap table.



How to Remove a Bet
To remove a bet on the IGS crap table simply move the cursor (hand) over the bet and click with the right 
mouse button.    Try this by moving the cursor over the $25 Pass Line bet and then click with the right 
mouse button.    Now the bet is removed.    Move the cursor over the Pass Line area and click with the left 
mouse button.    The $25 in the Bet Rail will now be on the Pass Line.

RULE:    Use the right mouse button to 
remove a bet.



 How to Roll the Dice
Now that that we have a $25 Field bet on the table, we are ready to roll the dice.    A pair of red dice can be 
found on the left side of the IGS crap table.    There are three different ways to manually roll the dice.

1. Click on the one of the two dice  with the left mouse button for a random roll. 
2. Click on the one of the two dice with the right mouse button.    A dialog box will pop up as shown below.    

Enter the dice number you want for the next roll.    When you click OK the dice will be rolled with 
the number you have intructed.

3. Click on the "Roll Dice"  button located in the Control Panel for a random roll.

Do not roll the dice yet.



Winning and Losing
When you win, a stack of chips representing your winnings will "appear" next to your bet.    After a brief 
moment, this stack will disappear.    Where did it go?    CASINO PLANNER assumes that you want to take 
down your winnings, not let it ride.    Therefore, your winnings automatically go from the table straight into 
your bankroll.    When you lose, your chips will be removed from the table.

The computer can payoff and remove bets faster than your eye can see.    Therefore, CASINO PLANNER 
has two convenient sounds that will indicate whether you won or lost money for your for a given roll of the 
dice.    If you net for a dice roll wins money, you will hear a bell sound.    If your net for a dice roll loses 
money, you will hear a "cash register" sound.



Comeout Roll
The Comeout roll is the first roll of a new game.    Notice the puck off to the side of the table    (upper left) 
with the black side facing up.    This means the next roll is a Comeout roll.    On a Comeout roll, you will 
hear the dealer say "Coming out! Coming out!".    Notice the "captions" box in the bottom-right corner of 
the screen below the Player Animation view.    Whenever the dealer talks, words will appear in captions 
box.    This box will keep you informed as to what is happening during the game.

Remember that on a Comeout roll, the Pass Line bet wins if 7 or 11 is rolled and loses if 2, 3 or 12 is rolled.
For this example, click on the one of the two dice with the right mouse button.    A dialog box will pop up.   
Enter "11" for the dice number and click OK.    You will see the dice roll across the table and stop with "11"
showing.    CASINO PLANNER will put your winnings ($25) next to your Pass Line bet just like in a real 
casino.    After a moment, CASINO PLANNER will automatically move your winnings into the Bankroll 
Rail and leave your original $25 Pass Line bet on the table, just like in a real casino.    

Notice the puck is off to the side of the table (upper left) with the black side facing up.    This means the 
next roll is still a Comeout roll.    Click on the one of the two dice with the right mouse button.    A dialog 
box will pop up.    Enter "4" for the dice number and click OK.    You will see the dice roll across the table 
and stop with "4" showing.    Nothing happens to your Pass Line bet since all this roll did was establish the 
Point as "4". 



Point Roll
Notice the puck has been moved on top of the number "4" with the white side facing up.    This means the 
next roll is a Point roll.    Remember on a Point roll, the Pass Line bet wins if the Point number is repeated 
(in this example, 4) before the 7 and loses if the 7 is rolled.    

Before rolling the dice, lets make a $50 double Free Odds bet.    Notice the Bet Rail contains $25.    
Therefore, in the Bankroll Rail click once on a green chip ($25) with the left mouse button and you will see 
$25 added to the Bet Rail.    Now the Bet Rail contains $50.    To make a $50 double Free Odds bet, simply 
move the cursor (hand) over the lower 50% of the Pass Line area and click with the left mouse button.    
The $50 in the Bet Rail is now "behind" the original $25 Pass bet as a Free Odds bet.

 

Again, click on the one of the two dice with the right mouse button.    Enter "7" and click OK.    You will 
see the dice roll across the table and stop with "7" showing.    This time your Pass Line bet lost.    CASINO 
PLANNER will remove your $25 Pass Line bet as well as your Free Odds bet of $50.    Since "7" was 
rolled before the Point was repeated, the game ends and CASINO PLANNER moves the puck off to the 
side of the table signifying the next roll is a Comeout roll and thus the start of a new game.    



Using "Auto Correct Bet Amounts
 "Auto Correct Bet Amounts" can make it easier to make bets on the table.    Let's look at an example that 
will make a $25 Pass Line bet.    After the point is established, the four inside Place numbers (5,6,8,9) will 
be made.    

Since you lost on the last roll, you must manually make another $25 on the Pass Line which is just what 
you would have to do at a real table.    But, the Bet Rail contains $50.    Therefore, in the Bankroll Rail click
once with the right mouse button on a green chip to reduce the Bet Rail by $25.    Or you can click the 
empty space just to the right of the chips in the Bankroll Rail to "clear" the Bet Rail and then click on a 
green chip in the Bankroll Rail with the left mouse button.    The Bet Rail now contains $25.    Click on the 
upper 50% of the Pass Line area to transfer the $25 in the Bet Rail on the table.    Now you will see $25 on
the Pass Line. 

Click on the one of the two dice with the right mouse button.    Enter "4" and click OK.    The dice will be 
rolled and 4 will be established as the Point.    Notice the puck move on top of the "4".    The next roll is a 
Point roll.

Now lets see how easy it is to bet $22 across the four inside Place numbers.    From the Options menu, 
choose General.    In the lower right area of the dialog box you will see a box called "Auto correct the bet 
amounts".    Select "Correct without prompts" and click OK.

Click the empty space just to the right of the chips in the Bankroll Rail to "clear" the Bet Rail and then click
on a red chip in the Bankroll Rail with the left mouse button.    The Bet Rail now contains $5.    Now using 
the left mouse button, click once on Place 5, Place 6, Place 8 and Place 9 bet areas of the table.    Notice that
the Place 4 and Place 9 bets have $5 each and the Place 6 and Place 8 bets have $6 each.    Even though the 
Bet Rail contained $5, CASINO PLANNER automatically corrected the Place 6 and Place 8 bets from $5 
to $6 by rounding to the nearest $6 boundary.    This makes it allot faster and easier to make bets on the 
table without having to worry about the "exact" bet amount.    $5 is now on the Place 5 and Place 9.    $6 is 
on the Place 6 and    Place 8.    There is now a total of $22 across the four inside Place numbers. 

Beginners may want to have "Auto correct the bets amounts" selected to "correct with prompts".    
Therefore, when an incorrect bet amount is made, CASINO PLANNER will prompt you with a pop-up 
window to notify you what is wrong with the bet amount and a suggest a proper amount. 



Using the Reset Button
There are times when you are in the middle of a session and you would like to start the session over again.   
The Reset button will remove all bets from the table and re-establish your original Bankroll.    Let's see how
this works.    

Click the Reset button  located in the Control Panel.    Notice your $25 Pass Line bet and the 
$22 across the inside Place numbers are gone.    Also, your bankroll is back at its original amount of $1,000.
Now you are ready to start to play a new session.



How to Speed Up the Pace of the game
There are three controls that affect the time it takes between dice rolls.    From the Options menu, choose 
General.

1. Locate the "Animation Settings" box.    Here you will see a check box called "Single step though 
results".    Make sure this check box is not active.    Also, drag both slide bars to the far right to 
shorten delays to their minimum.

2.    Locate "Player Animation" and make sure its check box is inactive.    This will prevent any people animation 
when the game is played and thus speed up the time between rolls.



Wrapping Up
In the Game Mode, you have a lot of different options and about 40 different types of bets you can make.    
Use this mode to practice playing your Betting Strategy for preparation to a real casino.
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Going Where No Software Has Gone Before 
The most basic concept behind CASINO PLANNER    is simple -- BE PREPARED when you go to the 
casino.    CASINO PLANNER    was conceived for this very reason.    Now it is possible to:

1) Have an objective basis for testing and comparing countless crap strategies.
2) Evaluate a single crap Strategy under many different Money Management conditions.
3) Use your home personal computer to dramatically increase your chances of winning at a real 

casino.    You will even learn how to have WinRatings of greater than 50%.



Introducing StrategyMaster
DEFINITION:    StrategyMaster.    A powerful planning tool that provides a wide range
of important information about countless crap strategies for the sole purpose of 
dramatically increasing your chances of winning at a real casino.

A StrategyMaster Guide, shown below, illustrates how easy StrategyMaster is to use.    First, you choose a 
crap Strategy that you would like to try out.    Second, you enter your Money Management numbers which 
defines the limits for your session at the table.    This includes starting Bankroll, Win Goal, Loss Limit and 
Time Limit.    Third, you enter the bets for your Strategy through a convenient window.    Next, you run 
StrategyMaster.    In the matter of minutes StrategyMaster tallies the results and provides you a wide range 
of important information that will give you a clear, overall picture of just how your Strategy performs.    

Not only can you use StrategyMaster to gain valuable insight for one Strategy, but you can also use 
StrategyMaster to objectively compare crap strategies in order to determine which ones are better. 



Concept of a "Session" 
DEFINITION:    Session.    The period of time from when you step up to the table, buy-in 
for your chips, and play a Betting Strategy until you reach your Win Goal, Loss Limit or 
Time Limit. 

RULE:    Each session much be played with one Strategy.

An important part of winning is understanding the concept of a session.    Whenever you play craps, your 
time at the table is referred to as a session.    A session begins when you step up to the table and buy-in for 
chips.    This is your starting bankroll.    You play a predefined Betting Strategy until you either hit your win 
goal, loss limit or time limit.    Everything is planned out for your session and nothing is left to chance.

Remember, StrategyMaster    is based on simulating thousands of sessions at the table to give you a clear, 
overall understanding of how your Strategy will perform in "real-world" situations.    Hence, when it's time 
for a real session at the casino, you can play just like you did with StrategyMaster.



Payoff Odds to Match the Casino You're Visiting
Different casinos can have different payoff odds for certain bets on the table (i.e. Field bet, Yo bet, Any 2, 
Any 12, etc.)    Therefore, it is important that the payoff for CASINO PLANNER match the payoff odds for 
the casino you plan to visit.    This will ensure that StrategyMaster will accurately predict what can happen 
during your next trip to the casino.    

From the Options menu, choose Casino.    The "Setup Casino" dialog box will appear as shown below. 

CASINO PLANNER already has preloaded some of the more popular casinos in the United States.    You 
can select one from a list located in the upper left part of the dialog.    These casinos already have been 
setup with proper rules and payoffs.    Be careful not to change the settings of a "preset" casino, because if 
you do, they will be saved when you exit the dialog.    If the casino you are going to visit is not listed, you 
may click the "new" button and add new casinos to the list.    If you do not know the payoff odds, you can 
call the casino and ask them to send you their "Gaming Guide" in the mail.



Basic Terminology
Before we go over some examples on how to setup and run StrategyMaster, it is important to review some 
basic terminology that is used throughout this manual.    

DEFINITION:    Simulation.    StrategyMaster plays your Strategy automatically until a 
predefined number of sessions at the IGS crap table is completed.

DEFINITION:    Strategy. A generic term that refers to a "Betting Strategy" that is played 
under    Money Management constaints.

DEFINITION:    Money Management.    Defines starting Bankroll, Win Goal, Loss Limit 
and Time Limit for a given session at the crap table.

DEFINITION:    Betting Strategy.    This A consistent way of betting which defines the 
types of bets to make, for how much and when to make them for a given session at the 
crap table.

DEFINITION:    New Betting Strategy.    A new Betting Strategy will be created if one or 
more of the following occurs to an existing Betting Strategy:    1) Bet type (Pass, Buy, 
Field, etc.) is changed, 2) Amount of bet is changed, or 3) the time at which a bet is to be 
made is changed.

Therefore, be careful when you see the two words "Strategy" and "Betting Strategy".    The word "Strategy"
alone is meant to refer to the entire Strategy, including both Money Management numbers and a Betting 
Strategy.    "Betting Strategy" is meant to refer to only the bets of a given Strategy and DOES NOT include 
Money Management. 



Two Ways to Use StrategyMaster
StrategyMaster will help you to dramatically improve your chances of winning for your next session at a 
crap table.    There are two ways to use StrategyMaster:

Related Topics:
1. Objectively compare different Betting Strategies
2. "Fine-tune" one Betting Strategy



1. Objectively compare different Betting Strategies
This is where you begin with StrategyMaster.    All Betting Strategies, no matter how good they are, will 
eventually produce profits for the casino, at your expense.    Therefore, a superior Betting Strategy is one 
that keeps your losses down to a minimum over time.    CASINO PLANNER has a unique feature called 
NET-per-Hour, to indicate what your expected losses should be.    

DEFINITION:    NET-per-Hour.    The amount of money you can expect to lose, over 
time, for every hour    that a particular Betting Strategy is played.    (i.e. NET-per-Hour = 
"expected cost")

RULE:    The NET-per-Hour is the only means that can be used to objectively compare 
Betting Strategies in order to determine which one is superior.

OBSERVATION:    When comparing Betting Strategies, the one with the lower NET-per-
Hour (with five-star rating) will be always be superior, no matter what Money 
Management numbers are used in the future.



2. "Fine-tune" one Betting Strategy
Once you have compared various Betting Strategies and found one with a low NET-per-Hour, then you
are ready to "fine-tune" its performance.    

DEFINITION:    Fine-tune.    To adjust the Money Management numbers in such a way 
that a Betting Strategy will yield a desired performance.    (i.e. chances of winning, length
of playtime, money required to play, etc.)

Your Money Managementnumbers directly effect how long you can expect to play, what your chances 
are of winning, how much money you will need to play your strategy, and other important aspects of 
your Betting Strategy.    You will see that by adjusting the Money Management numbers, you can 
dramatically effect the Fundamental Five, Highs and Lows, and Averages for your Betting Strategy.    
Also, fine-tuning one Betting Strategy plays a bigger role in what can happen during your next trip to 
the casino, than switching over to a different Betting Strategy.    In other words, most Betting Strategies
offer a good chance for you to win, but it is your Money Management numbers that are paramount in 
being able to walk away from the table a winner.    A bad Betting Strategy can be helped by proper 
Money Management numbers, but a good Betting Strategy can not be helped with bad Money 
Management numbers. 



How to Setup the StrategyMaster Mode
From the Options menu, choose Mode.    A dialog box titled "Mode" will appear as shown below.    
Select StrategyMaster Mode.    Click OK.    This will take you back to the IGS crap table



Two ways to begin a Strategy
There are two ways to begin working with a strategy before running StrategyMaster:    

Related Topics:
1. Create a new Strategy from scratch
2. Open a Strategy that has been previously saved



1. Create a new Strategy from scratch
This is done by going to the File menu and choosing New.    This will open the "Money 
Management" window where you will give your Strategy a brief description and setup your Money 
Management numbers for your session.    You must then enter    your Betting Strategy.



2. Open a Strategy that has been previously saved
This is done by going to the File menu and choosing Open.    From here you can pick from a list of 
available strategies that already have Money Management numbers and a Betting Strategy.    They 
are all setup and ready to be run by StrategyMaster or you can modify one of these strategies and 
save it under a different name. 



Basic Methods
The following shows the basic ways in which you can use StrategyMaster .

Related Topics:
How to Setup and Run StrategyMaster
How to Compare Betting Strategies
How to Use the "Money Management Assistant
How to Look at the Results While You Wait!
How to Improve the Results
Improving Your WinRating
Increasing Your Playtime
Minimizing Your Cost to Play
How to Obtain WinRatings of Greater than 50%



How to Setup and Run StrategyMaster
1.    From the File menu, choose New.    The "Money Management" dialog box will appear.    This is where 

you will always begin to setup a new Strategy.

a. Give your Strategy a short name under    "Strategy Description".

b. Enter your Money Management numbers for Win Goal, Loss Limit, and Time Limit.

c. Click OK. This will take you back to the IGS crap table.

2. From the Options menu, choose StrategyMaster.    The "StrategyMaster Options" dialog box will 
appear.    Enter a value for "Number of Sessions per Run".

3. From the StrategyMaster menu, choose Setup Bets, then Bets (or click "Betting Strategy" button 
located below the IGS crap table).    The "Betting Strategy" dialog box will appear.

a. Click on the check box for a bet that is part of your Betting Strategy.    The "Make A Bet" 
dialog box will appear. 

b. Enter the aspects about this bet to match your Betting Strategy (bet amount, when to make the 
bet, etc.).

c. Click OK.    The "Betting Strategy" dialog box will appear again.

d. Repeat steps 1b through 3c until your Betting Strategy is completely entered.

4. From the StrategyMaster menu, choose Run, then Go (or click "Run" button located below the IGS 
crap table).    CASINO PLANNER will now shrink down to an icon for maximum speed as shown 
below:

 StrategyMaster will stay an icon during the entire simulation.    When StrategyMaster is completed, a 
small pop up    will say "StrategyMaster is Finished".    Click OK and the Overall Results window will 
automatically be displayed with all the important information about your Strategy. 

5. You can accept these results, or go back and modify your Strategy by repeating steps 3 and 4.



How to Compare Betting Strategies
A very important part of planning a successful trip to the casino is being able to try out AND compare 
various Betting Strategies that are of interest to you.    There are countless Betting Strategies in the game of 
craps and it is NOT obvious which ones are better than others.    StrategyMaster provides an easy solution 
to this age old problem by allowing you to objectively compare Betting Strategies based on their "NET-per-
Hour".    

Just like in coin flipping you can expect heads to show up 50% over time, the NET-per-Hour also represents
a consistent number over time that is practical for objectively comparing Betting Strategies based on 
expected cost.    Obviously you will want to play a strategy with a low cost.    The NET-per-Hour can be 
found in the Overall Results window located under the StrategyMaster menu.

For short simulations, the NET-per-Hour can be erratic and even produce non-negative results.    Even 
though this really happens in "real world" situations over short periods of time, you need a stable NET-per-
Hour for comparing Betting Strategies.    In order to obtain stable results for the NET-per-Hour, it is 
recommended that you run StrategyMaster long enough to have an accuracy rating of "five-stars. 

OBSERVATION:    Money Management numbers have no effect on the NET-per-
Hour.    

RECOMMENDATION:    To obtain a minimal "five-star" rating for NET-per-Hour, set 
the Money Management numbers to match the dialog box shown below and set the 
"Number of Sessions per Run" to 1000.    

OBSERVATION:    To obtain maximum accuracy for NET-per-Hour, set the Money 
Management numbers to match the dialog box shown below and set the "Number of 
Sessions per Run" to 20000.    However, keep in mind that the simulation time will 
probably exceed 20 hours using a 90MHz Pentium PC.    
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To access the Money Management Dialog, go to the StrategyMaster menu, choose Setup Strategy, then 
Money Management.    To access the dialog box to change the "Number of Sessions per Run", go to the 
Options menu and choose StrategyMaster.

By allowing all sessions to end only by reaching the Time Limit, your strategy will run "wide open", with 
very little interruption.    The above Money Management numbers will give a total PLAYTIME of 40,000 
hours and    thus meet the requirement to have a "five-star" rating.    With these Money Management 
numbers, only the NET-per-Hour and VigRating    will have meaning in the Overall Results window.    But 
that's all right, since in objectively comparing two Betting Strategies, the NET-per-Hour is the only number 
that you are interested in.    

Only in "fine-tuning" one strategy, will all the other information in the Overall Results window become 
important.    Once you start "fine-tuning" a Betting Strategy,    the NET-per-Hour is no longer important 
since it is already known from a previous run and since the Money Management numbers have no effect the
NET-per-Hour.    Use the following procedure to obtain a stable NET-per-Hour when comparing Betting 
Strategies:

1.    From the File menu, choose New.    The "Money Management" dialog box will appear.

a. Give your Strategy a short name under    "Strategy Description".

b. Enter your Money Management numbers as follows:

Win Goal = 1000000 (one million dollars)

Loss Limit = 1000000 (one million dollars)

Time Limit = 40
Click OK. This will take you back to the IGS crap table.

2. From the Options menu, choose StrategyMaster.    The "StrategyMaster Options" dialog box will 



appear.    Enter 1000 for "Number of Sessions per Run".
3. From the StrategyMaster menu, choose Setup Bets, then Bets (or click "Betting Strategy" button 

below the IGS crap table).    The "Betting Strategy" dialog box will appear.

a. Click on the check box for a bet that is part of your Betting Strategy.    The "Make A Bet" 
dialog box will appear. 

b. Enter the aspects about this bet to match your Betting Strategy.

c. Click OK. The "Betting Strategy" dialog box will appear again.

d. Repeat steps 3a through 3c until your Betting Strategy is completely entered.
4. From the StrategyMaster menu, choose Run, then Go (or click "Run" button below the IGS crap 

table).    CASINO PLANNER will now shrink down to an icon for maximum speed and run until 
StrategyMaster has finished the simulation.    When StrategyMaster is completed, a small pop up    
will say "StrategyMaster is Finished".    Click OK and the Overall Results window will 
automatically be displayed.    The "NET-per-Hour" will now indicate your expected cost to play 
your Strategy.    Ignore all other information in this window since they have no meaning with this 
type of run.



How to Use the "Money Management Assistant 
1.    From the File menu, choose New.    The "Money Management" dialog box will appear. 

a. Give your Strategy a short name under    "Strategy Description".

b. Ignore the Money Management numbers for now.

c. Click OK. This will take you back to the IGS crap table.

2. From the Options menu, choose StrategyMaster.    The "StrategyMaster Options" dialog box will 
appear.    Enter a value for "Number of Sessions per Run".

RECOMMENDATION:    Always set "Number of Sessions per Run" to 100 when using 
the Money Management Assistant.

3. From the StrategyMaster menu, choose Setup Bets, then Money Management. The "Money 
Management" dialog box will appear.

a. Click on the "Money Management Assistant" button.    CASINO PLANNER will now shrink 
down to an icon for maximum speed and run until StrategyMaster has finished the simulation.   
When StrategyMaster is finished, the "Money Management" dialog box will re-appear with 
updated Money Management numbers for Win Goal and Loss Limit.    These numbers provide 
a "good starting point" for your Betting Strategy.

b. Click OK. This will take you back to the IGS crap table.

4. From the StrategyMaster menu, choose Run, then Go (or click "Run" button located below the IGS 
crap table).    CASINO PLANNER will now shrink down to an icon again for maximum speed and run 
until StrategyMaster has finished the simulation.    When StrategyMaster is completed, a small pop up   
will say "StrategyMaster is Finished".    Click OK and the Overall Results window will automatically 
be displayed with all the important information about your Strategy. 

5. You can accept these results, or see "How to fine-tune" a Betting Strategy.



How to Look at the Results While You Wait!
A StrategyMaster run can take a long period time before a simulation is finished, depending on how you 
setup StrategyMaster.    During a simulation, CASINO PLANNER will stay iconized until all the sessions 
of the simulation are completed.    While you are waiting for StrategyMaster to finish, you can open and run
other games or applications.    

1. To do this, simply go to the Program Manager and open any application or game you want.    While 
you are using these other programs, StrategyMaster while still be running in the background.    When 
StrategyMaster is finished, you will automatically be notified.

2. Or, instead of running another program, there is something that might be more interesting to do while 
you wait.    You can look at the results as they are being updated by StrategyMaster.    To do this, click 
once on the CASINO PLANNER icon to bring up a pop-up menu.    By selecting Restore, the IGS crap
table will appear.    

SHORTCUT:    Instead of clicking once on the CASINO PLANNER icon to bring up a 
pop-up menu, you can double click on the icon to directly bring up the IGS crap table. 

RULE:    You can abort while in the middle of a simulation.    When CASINO PLANNER
is iconized, double click on the icon to bring up the IGS crap table and click on the 
"STOP" button.    Now you are back in control of CASINO PLANNER.

Here you will see the main screen updating as StrategyMaster is running real time.    Notice in the 
lower right hand corner of the window text that says "X.X% Complete" indicating how much of the 
simulation that StrategyMaster has completed.

3. There are alot of different things you can do while you are waiting for StrategyMaster to complete the 
simulation.    Now lets look at the results window.    From the StrategyMaster menu, choose Results 
then choose Overall.    You should now see the Overall Results window appear.    Here you watch all 
the important information about your strategy update while you wait.    Notice in the lower left portion 
of the window text that says "% Session Completed" indicating how much of the simulation that 
StrategyMaster has completed.

4. Click OK button in the Results window.    This will take you back to the IGS crap table and you will 
again see the screen updating.    If you didn't like the looks of the results or you just want to stop the 
simulation, you can prematurely stop StrategyMaster.    To do this, click the Stop button located in the 
Control Panel below the IGS crap table.    Notice the Stop button turns into a Run button.    At this 
point you may do what ever you want (i.e. modify the strategy, open a new startegy, exit CASINO 
PLANNER, etc.).    For this example, just click the Run button so that StrategyMaster can continue to 
complete the simulation.

5. There are other things you can do while you wait.    From the StrategyMaster menu, choose Results 
then choose Bankroll Graph.    You should now see the the    "Session Bankroll Graph" appear in the 
lower right side of the screen as shown below.



This graph shows how your bankroll changes for each session as the simulation is running.    This 
graph is actually a resizable window.    Therefore, you can treat it as any other window and move it 
around, expand it and resize it.    

6. All these graphics are nice to watch but it slows down StrategyMaster.    To have StrategyMaster run 
full speed again, it must be shrunk back to an icon.    To do this, go to the upper right most part of the 
IGS crap table window and click the "minimize" button (all windows have a minimize button in upper 
right corner to shrink the window into an icon).    Now you will see CASINO PLANNER again as an 
icon.

OBSERVATION:    When CASINO PLANNER is iconized, maximum speed for the 
simulation will be obtained.    On the Contrary, when CASINO PLANNER is NOT 
iconized,    the simulation will slow down considerably since time must be spent updating 
the graphics. 

RECOMMENDATION:    After StrategyMaster has run for a while, take a peek at the 
results to see how they're doing.    If the results look good then shrink CASINO 
PLANNER back to an icon for maximum speed, if the results look real bad, abort the 
StrategyMaster run altogether.



How to Improve the Results
If you like one Betting Strategy (i.e. $5 Pass with double odds) but you are not happy with the results, you 
can adjust the Money Management numbers to improve your Strategy.    The following shows how to adjust
the Money Management numbers to get the type of results you are looking for:



Improving Your WinRating
You can increase your WinRating by doing one or more of the following:

1) Decrease your Win Goal.
2) Decrease your Time Limit.
3) Increase your Loss Limit.

NOTE: By doing the opposite of the above, you can decrease your WinRating.



Increasing Your Playtime
You can increase your playing time by doing one or more of the following:

1) Increase your WinGoal.
2) Increase your Time Limit.
3) Increase your Loss Limit.

NOTE: By doing the opposite of the above, you can decrease your Playtime.



Minimizing Your Cost to Play
There are actually two types of costs that should be taken under consideration when evaluating the results 
from a StrategyMaster run:

1. The expected cost to play a session at the table.    This is the "NET-per-Session" which is part the 
Fundamental Five.    You can decrease your expected session costs by doing one or more of the 
following:

1) Decrease your WinGoal.

2) Decrease your Time Limit.

3) Decrease your Loss Limit.

By doing the opposite of the above, you will increase your average session costs.

OBSERVATION:    The lower your expected "NET-per-Session", the lower your expected
"Playtime per Session" and vice-versa.

2. The expected cost to play each hour at the table.    The is the "NET-per-Hour" listed in the Overall 
Results window.    Changing the Money Management will not affect "NET-per-Hour".    Instead, the 
only way decrease the "NET-per-Hour" is to change your Betting Strategy.    You can do this by doing 
one or more of the following:

1) Decrease your bet amounts.

2) Change bet types (i.e. Hardways, Field, etc.) to ones that have lower vigs or eliminate them 
altogther from your Betting Strategy .



How to Obtain WinRatings of Greater than 50%
For a given session at the table, if you are willing to risk more money than you are willing to win, you can 
actually have the odds of winning in your favor over the casino (i.e. WinRating of greater than 50%).    No 
matter what your Betting Strategy is, use Money Management numbers that have a Loss Limit greater than 
your Win Goal and try to make sure that your sessions don't reach their Time Limit.    In other words, your 
sessions should end by either reaching your Win Goal or Loss Limit.    If your Loss Limit is about ten times 
higher than your Win Goal, you can actually achieve WinRatings of around 90%.

You will see that your WinRating is independent of the amount of money you want to win.    In others 
words, you can have, for example, an 85% chance to win any amount of money you want.    It all depends
on how much you are willing to risk.    Let's look at two players who are both betting the Pass Line only.    
"Player A" wants to have an 85% chance of winning $100, and "Player B" wants an 85% chance to win 
$1000.    There are many Strategies that would have solutions for both to get what they want.    A solution 
for each player is given below:

Amount on Pass Line Win Goal Loss Limit Time Limit WinRating

"Player A" $100 $100 $700 3 hrs. 85%

"Player B" $1000 $1000 $7000 3 hrs. 85%

RECOMENDATION:    When trying to achieve a high WinRating, set the Time Limit to 
40 hrs so that you will not prematurely end a session. Next, set your Loss Limit between 
five and ten times greater than your Win Goal, and run StrategyMaster.    When 
completed, note your maximum Playtime listed under "Highs and Lows" to see if it is 
within a reasonable period of time (i.e. not greater than five or six hours).



Example:
How to Plan a Winning Trip to the Casino
StrategyMaster is meant to be used by ANYONE who is going to the casino.    Let's go over some practical 
issues that all crap players face.    Let's say you are going to the casino this weekend and you're not sure 
which Betting Strategy to use and how much money to bring, etc.    This example will illustrate how simple 
it is to use CASINO PLANNER to prepare for a winning trip to the casino.    It's as easy as 1-2-3!!!

Step 1 - Compare different Betting Strategies that are of interest to you and choose the one with the 
lower NET-per-Hour.

Step 2 - For the one Betting Strategy that you have selected, use the Money Management Assistant to 
help you with a "good starting point" for your Money Management numbers (i.e Win Goal and 
Loss Limit).

Step 3 - Fine-tune your Betting Strategy simply means adjusting the Money Management numbers in 
order to get the results you are looking for (i.e. WinRating, playtime, cost, etc.).

Let's go to the casino!

Related Topics:
Step 1 - Comparing Different Betting Strategies
Step 2 - Using the Money Management Assistant
Step 3 - Fine-tuning Your Strategy



Step 1 - Comparing Different Betting Strategies
Which of the following two Betting Strategies is better?    In other words, which one has a lower expected 
cost?    

1. Betting Strategy A: $10 Pass bet w/$20 double odds

2. Betting Strategy B: $12 Place 6 and $12 Place 8 on Point rolls only

(Note that during the course of a game, "Strategy A" is betting a total of $30, while "Strategy B" is betting 
$24.)

It's not obvious which strategy is better.    "Strategy A" is the popular Pass bet with double odds.    "Strategy 
B" takes advantage of the frequent rolls of 6 & 8 and combines this with low vig bets like the Place 6 and 
Place 8.    There are five ways to roll a 6 and five ways to roll an 8.    On the other hand, there are six ways 
to roll a 7.    Therefore,    "Strategy B" has ten ways to win and six ways to lose.    That's almost a 2:1 chance
of winning with either the Place 6 or Place 8.    Not a bad strategy.    

So which one is better, "Strategy A" or "Strategy B"?    The only way to know is to compare the NET-per-
Hour for each of the two Betting Strategies.    For obvious reasons, the one with the lowest NET-per-Hour is
the better of the two.    

Setting Up "Strategy A"
(Recall section titled, "How to Objectively Compare Betting Strategies")

1.    From the File menu, choose New.    The "Money Management" dialog box will appear.    In the 
Strategy Description box, type "$10 Pass w/double Odds".    Enter a    Win Goal = 1000000, Loss Limit
= 1000000 and Time Limit = 40.    Click OK.    This will take you back to the IGS crap table.    

2. From the StrategyMaster menu, choose Setup Bets then choose Bets.    The "Betting Strategy" dialog 
box will appear.    This dialog box has over 40 check boxes that represent all individual crap bets on the
table.

SHORTCUT:    A quicker way to bring up the "Betting Strategy" dialog box is to click on 
the "Betting Strategy" button located in the Control Panel below the IGS crap table. 

3. Click on the check box just to the left of the word "Pass".    The "Make A Bet on the Pass Line" dialog 
box will appear.    Type in a Fixed Bet amount of $10.    

4. Click on the Free Odds button.    The "Make A Bet on the Pass Line Odds" dialog box will appear.    
Select "double odds" for when the point is "4 or 10", "5 or 9" and "6 or 8".    Your Free Odds bet will be
$20 no matter what the point is.    Click OK.    This will take you back to the "Make A Bet on the Pass 
Line" dialog box.    Click OK.    This will take you back to the IGS crap table.

5. Next, you must setup the total number of sessions that you want StrategyMaster to simulate.    It is 
from these simulations that StrategyMaster will tally the results for your Strategy.

From the Options menu, choose StrategyMaster.    The "StrategyMaster Options" dialog box will 
appear.    Type in 1000 for the Number of Sessions.    Click OK.    This will take you back to the IGS 
crap table.

Running StrategyMaster to Obtain the Results
1. StrategyMaster knows your Betting Strategy and number of sessions to simulate.    Now, you are ready 

to run StrategyMaster to see how the strategy will perform.    Click on the Reset button located below 
the IGS crap table, then click on the Run button.    CASINO PLANNER will shrink down to an icon 
for maximum speed as shown below.



2. StrategyMaster will stay iconized until all 1000 sessions of the simulation are completed.    The icon 
will indicate percent complete as StrategyMaster is running.    As soon as the simulation is complete, 
you will see a small window appear as shown below. 
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3. Click OK.    You will see the Overall Results window appear with similar results to the one shown 
below. 
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The only results that have any meaning in the Overall Results window for this type of simulation is the 
NET-per-Hour and VigRating.    For purposes of objectively comparing Betting Strategies, all you need
to do is write down the the NET-per-Hour for future comparison.    . (Notice the VigRating is 0.61%.    
This happened to be exactly the ideal value of 0.61%.    Normally the simulation will give a result very 
close to its ideal value.)

4. To save this Betting Strategy, go to the File menu and choose Save.    In the dialog, give your strategy a
file name "strat_a.wc1.    Click OK.    This will take you back to the IGS crap table.

Setting Up "Strategy B"
The procedure to obtain the NET-per-Hour for "Strategy B" is the same as for "Strategy A".    

1.    Instead of going to the File menu and choosing New, let's look at another way to to setup a strategy.    
From the StrategyMaster menu, choose Setup Bets then choose Money Management.    The "Money
Management" dialog box will appear.    In the Strategy Description box, type "$12 Place 6 and 8 on 
Point rolls".    Leave the Money Management numbers for Win Goal, Loss Limit and Time Limit the 
same as from "Strategy A".    Click OK.    This will take you back to the IGS crap table.    

2. From the StrategyMaster menu, choose Setup Bets then choose Bets.    The "Betting Strategy" dialog 
box will appear.    The check box just to the left of the word "Pass" and the check box just to the left of 
the word "Take Odds" will both alraedy be active from the previous run.    Click on the active check 
box next to "Pass".    The "Make a Bet on the Pass Line" dialog box will appear.    De-select the check 
box for "Computer Controlled Bet" to quickly disable the Pass bet, as well as, its free odds.    Click 
OK.    This will take you back to the Betting Strategy Dialog box.    

3. Click on the "Place 6" check box.    The "Make A Bet on Place 6" dialog box will appear.    

A. Type in a "Fixed Bet" amount of $12.    

B. Under Conditional Betting, select "Point Rolls Only".    Make sure that all check boxes are 
active for each Point, except for when the Point is 6

Click OK.    This will take you back to the Betting Strategy Dialog.    

4. Click on the "Place 8" check box.    The "Make A Bet on Place 8" dialog box will appear.    

A. Type in a "Fixed Bet" amount of $12.    

B. Under Conditional Betting, select "Point Rolls Only".    Make sure that all check boxes are 
active for each Point, except for when the Point is 8.

Click OK.    This will take you back to the Betting Strategy Dialog.    Click OK again.    This will take 
you back to the IGS crap table.

5. (1000 sessions is already set for "Number of Sessions per Run" from the previous simulation.)    

Running StrategyMaster to Obtain the Results



1. StrategyMaster knows your Betting Strategy and number of sessions to simulate.    Now, you are ready 
to run StrategyMaster to see how this strategy will perform.    Click on the Reset button located below 
the IGS crap table, then click on the Run button.    CASINO PLANNER will shrink down to an icon 
for maximum speed.

2. StrategyMaster will stay iconized until all 1000 sessions of the simulation are completed.    The icon 
will indicate percent complete as StrategyMaster is running.    As soon as the simulation is complete.    
Once complete, click OK on pop-up window that says "StrategyMaster is Finished!".    You will see the
Overall Results window appear with similar results to the one shown below. 

The only results that have any meaning in the Overall Results window for this type of simulation are 
the NET-per-Hour and VigRating.    For purposes of comparing Betting Strategies, all you need to do is
write down the the NET-per-Hour for future comparison. (Notice the VigRating is 1.59%.    This is very
close to the ideal value of 1.52%)

4. To save this strategy, go to the File menu and choose Save.    In the dialog, give your strategy a file 
name "strat_b.wc1.    Click OK.    This will take you back to the IGS crap table.

Conclusion
The results from all four StrategyMaster runs are shown below:

Strategy A => Expected NET-per-Hour = -$5.04/hr

Strategy B => Expected NET-per-Hour = -$9.86/hr

It is now evident that Strategy A is much better than Strategy B.





Step 2 - Using the Money Management Assistant
Now you've determined which Betting Strategy you will use, it is now time to determine which Money 
Management numbers you should use.    Your Money Management numbers will play an important role in 
answering the following questions:

1. How much Money should you bring to play your strategy?    
2. What is a realistic Win Goal for your strategy?    
3. How do you determine a "worst case" Loss Limit?    
4. How much Playtime can you expect at the table?    

These are important questions that every player should have answers to before stepping up to the crap table.
This is where the Money Management Assistant can help in a big way.    For a given Betting Strategy, the 
Money Management Assistant will automatically give you a "good starting point" for a realistic Win Goal, 
Loss Limit and Bankroll needed to play your strategy.    But what is meant by a "good starting point"?

OBSERVATION:    There is no one set of Money Management numbers that is ideal for 
all players.

The Money Management Assistant cannot give you one set of ideal Money Management numbers because 
there are many different types of players.    For example, lets look at two players, Mr. Aggressive and Mr. 
Conservative.    Both players will be betting the exact same way (i.e. $10 Pass Line w/double Free Odds).    
Mr. Aggressive wants to win a lot of money and is willing to accept high risk.    Mr. Aggressive will require 
one set of Money Management numbers.    Mr. Conservative on the other hand, is willing to accept smaller 
winnings at a lower risk.    Hence, Mr. Conservative will have a different set of Money Management 
numbers from Mr. Aggressive -- even though their Betting Strategy is the same (i.e. $10 Pass Line 
w/double Free Odds). 

Since there is no one set of Money Management numbers for everyone, the Money Management Assistant 
splits right down the middle to give you Money Management numbers that are neither super aggressive nor 
very conservative.    That way, no matter what kind of player you are, there will be only a slight adjustment 
to the Money Management numbers.    But before you can adjust the Money Management numbers, you 
must first have a "good starting point".    

You only need to use the Money Management Assistant once for each new Betting Strategy that you create. 
After the Money Management Assistance gives you a "good starting point", it's up to you to fine-tune the 
Money Management numbers until the results in the Overall Results window matches what you are looking
for.    (i.e. high WinRating, long Playtime, low cost, etc.)

Setting Up the Strategy
1.    From the File menu, choose Open.    Select the file called "Strat_a.wc1".    

2. Before using the Money Management Assistant you must setup the total number of sessions that you 
want StrategyMaster to simulate.    It is from these simulations that StrategyMaster will provide your 
Money Management numbers.

From the Options menu, choose StrategyMaster.    The "StrategyMaster Options" dialog box will 
appear.    Type in 100 for the "Number of Sessions per Run".

RECOMMENDATION:    When using the Money Management Assistant, 100 sessions 
per run is all that is needed to give reasonable Money Management numbers.

Click OK.    This will take you back to the IGS crap table.

3. StrategyMaster knows your Betting Strategy and number of sessions to simulate.    Now you're now 
ready to use the Money Management Assistant.

From the StrategyMaster menu, choose Setup Bets, then choose Money Management.    The 
"Money Management" dialog box will appear. 



Before running the Money Management Assistant, StrategyMaster must know the Time Limit for your 
Strategy.    For this example, type in 3 hours.    The Bankroll, Win Goal and Loss Limit numbers do not 
matter at this point since these numbers will be overriden by the Money Management Assistant.

Running the Money Management Assistant
1. Click on the "Money Management Assistant" button.    CASINO PLANNER will now shrink down to 

an icon to obtain maximum speed.

2. StrategyMaster will stay iconized until all 100 sessions of the simulation are completed.    The icon will
indicate percent complete as StrategyMaster is running.    As soon as the simulation is completed, you 
will automatically see the "Money Management" window appear with similar results as shown below. 

Notice that StrategyMaster has updated the Money Management numbers in the dialog.    The Win 
Goal and Loss Limit numbers in this dialog box were updated by StrategyMaster to give you about a 
50% WinRating for your Betting Strategy, in this case, $10 on the Pass Line with $20 double Odds.

Click OK.    Double click on the CASINO PLANNER icon to bring back the IGS crap table.    (The 
icon is on top of your Windows wall paper)

Running StrategyMaster to Obtain the Results
1. In order to obtain fairly accurate results, and at the same time, not take too long to run, you should 

change the "Number of Sessions per Run" to at least 1000.    From the Options menu, choose 
StrategyMaster.    The "StrategyMaster Options" dialog box will appear.    Type in 1000 for the 
Number of Sessions per Run.

Click OK.    This will take you back to the IGS crap table. 

2. Now you are ready to run StrategyMaster with the new numbers from the Money Management 
Assistant.    Click on the Reset button located in the Control Panel below the IGS Crap table, then click
on the Run button.    CASINO PLANNER will shrink down to an icon for maximum speed. 

3. StrategyMaster will stay iconized until all 1000 sessions of the simulation are completed.    The icon 
will indicate percent complete as StrategyMaster is running.    As soon as the simulation is complete, 
you will see a small window pop-up window appear saying, "StrategyMaster is Finished!". 

Click OK.    You will see the Overall Results window appear with similar results to the one shown 
below. 
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The results given under the "Fundamental Five", "Highs and Lows", and "Averages" are all reported 
with respect to a given session.    The results repported under "Totals" at the botton of the window 
represent cumulative totals for all sessions simulated.    Click on the "Sessions" button.    A window will
appear similar to the one shown below.    This scrolling window shows the results for each of the 1000 
sessions that were simulated by StrategyMaster. 
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Click on the text "Exit" in upper left part of the window.    This will take you back to the "Overall 
Results" window.

Understanding the Results
Let's see how to interpret the results for the Fundamental Five. 

a. The WinRating is 49.4% +/-5pts.    This means that you can expect to win about 49% of your 
sessions at the table, or in other words, you can expect to win about 5 out of every 10 sessions you 
play.

b. The WinGoal Rating is 40.5%.    This means that you can expect to reached your Win Goal ($215) 
about 40% of of the time, or in other words, you can expect to reach your Win Goal about 4 out 
every 10 sessions you play.

c. The Avg. Playtime and Avg. Net-per-Session should always be looked at together.    With this 
strategy, you can expect your session to last an average of 1 hr. and 42 min. and during this time 
you can expect your session to cost you an average of $7.81.    

d. The VigRating is 0.56%.    Since the Pass Line w/double odds was the only bet, we know the ideal 
value is 0.61%.    StrategyMaster was close enough considering only 1000 sessions were simulated.

OBSERVATION:    For short simulations with a total Playtime of less than 1000 hours,    
the VigRating can sometimes show up as a negative number (indicating the odds are in 
your favor).    This is not a flaw in the software but rather is a real possibly for short runs. 
However, over much longer simulations the VigRating will eventually represent a 
consistent number which represents the House Advantage for your entire Strategy.

Let's see how to interpret the results for the Highs and Lows. 
a. The "Most ever AHEAD" for a given session was $262.    Looking back up in the Fundamental 

Five area of the window you can see the Win Goal for this strategy was $215.    Since the win goal 
was $215, how can the most ever ahead be $262?    The answer is simple.    The winnings after one 
of the simulated sessions was $212, not yet at your win goal so the session didn't end.    Then, the 
very next game won ($50) and brought the total winnings to $262 which ended that session.

b The "Most ever DOWN" for a given session was $268. Looking back up in the Fundamental Five 
area of the window    you can see the Loss Limit for this strategy was $240.    Since the Loss Limit 
was $240, how can the most ever ahead be $268?    The answer again is simple.    The losses after 
one of the simulated sessions was $238, not yet at your Loss Limit so the session didn't end.    Then,
the very next game lost ($30) and brought the total losses to $268 which ended that session.

c. Playtime for Winning Session.    This is the range of time that was played when a session ended in 
a win.    In this case, the range of time was 0:12 to 3:06.    What is important to note here is that 
there is a very large "window" of time in which you can hit your Win Goal.    Some sessions hit 
their Win Goal in only 12 minutes.    This can be good or bad.    If you just want to win, then 12 
minutes might be OK.    But if you want more Playtime then 8 minutes is not good.    On the other 
hand, there was at least one session (i.e 3:06) that you could play all the way to your Time Limit 
and still not reach your Win Goal. 

d. Playtime for Losing Session.    This is the range of time that was played when a session ended in a 
loss.    In this case, the range of time was 0:10 to 3:08. What is important to note here is that there is
a very large "window" of time in which you can hit your Loss Limit.    Some sessions hit the Loss 
Limit in only 10 minutes.    This is not good to have some of your sessions lose all your money so 
fast.    On the other hand, there was at least one session (i.e. 3:08) that you could play all the way to 
your Time Limit and still not reach your Loss Limit.    You will see in just a moment how to fine-



tune your Money Management numbers to get a much longer minimum playtime, even if you lose. 

Let's see how to interpret the results for the Averages. 
a. Averages Winning Sessions.    When a session ended and you didn't lose, this is the amount of 

money you can expect to win and how long you can expect it will take.    In this case when a session
won, you walked away from the table with an average of $202 and each winning session played for 
an average of 1 hr. and 36 min.

b. Averages Losing Sessions.    When a session ended and you didn't win, this is the amount of money
you can expect to lose and how long you can expect it will take.    In this case when a session lost, 
you walked away from the tables down an average of $213 and each losing session played an 
average of    1 hr. and 48 min.

c. Average Net-per-Hour.    This is your average "cost per hour" to play your strategy.    This is a 
significant number since it is one of the primary indicators of what to expect your entertainment is 
going to cost and whether or not you can afford to play this strategy.    In this case, your can expect 
an average cost per hour of $4.60 to play this strategy.    

OBSERVATION:    On short simulations with a total Playtime of less than 1000 hours,    
the Net-per-Hour can sometimes show up as a positive number (indicating cash flow in 
your favor).    This is not a flaw in the software but rather is a real possibly for short runs. 
However, over much longer simulations the Net-per-Hour will eventually represent a 
consistent number which represents the expected Cost-per-Hour for your entire Strategy.

Conclusions
Let's look and see how the Strategy performed.

Advantages:
· The WinRating for this strategy is about 49%.    Not too bad considering most people lose at the casino.
· The WinGoal Rating for this strategy is about 40%.    Still not too bad.
· The average "cost per hour" to play this strategy is only $4.60. Very good entertainment value.
· The Fundamental Five indicates that you can play this strategy for an average of 1 hr. 42 min. and with

a cost on only $7.81.    Very reasonable.
· The VigRating is 0.56%.    An excellent VigRating since it keeps the casinos cut down to a bare 

minimum.    

Disadvantages:
· You can lose $240 (Loss Limit) in as little as 10 min.    Not good at all.    This can be fixed by "fine-

tuning" the Money Management numbers.



Step 3 - Fine-tuning Your Strategy
If You Are a Conservative Player

Let's continue where we left off.    You saw how to use the Money Management Assistant help you find a 
"good starting point" for your Money Management numbers.    Now you will see how to use these numbers 
to "fine-tune" your strategies performance to satisfy the Conservative Player.    Fine-tuning a strategy 
simple means modifying the Money Management numbers to get results to match the type of player that 
you are.    Let's say you are a conservative player and therefore want to have a very good chance of winning
(i.e. WinRating of greater than 50%) but not necessarily winning a lot of money.    In order to do this, we 
will begin with the "good starting point" that the Money Management Assistant gave us.

Remember that the Money Management Assistant numbers will give you about a 50% WinRating.    In 
order to get a higher WinRating, all you have to do is lower your Win Goal and/or increase your Loss 
Limit.    Let's start to "fine-tune" this Betting Strategy by adjusting the Money Management numbers.    

From the StrategyMaster menu, choose Setup Bets, then choose Money Management.    The "Money 
Management" dialog box will appear. 

1. Lower the Win Goal from $215 to $80.    Click OK. This will take you back to the IGS crap table.

2. Click on the Reset button located below the IGS crap table, then click on the Run button.    CASINO 
PLANNER will shrink down to an icon for maximum speed.

3. StrategyMaster will stay iconized until all 1000 sessions of the simulation are completed.    As soon as 
the simulation is complete, you will see a small pop-up window which says, "StrategyMaster is 
Finished!". 

4. Click OK.    You will see the Overall Results window appear with similar results to the one shown 
below:
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Notice that by lowering $215 to a more realistic Win Goal of $80, you have increased your chances of 
winning to around 70%.    This means that before you even start to play at the crap table, you know that
you have the advantage over the casino to win for that session at the table.    The odds are actually in 
your favor to win for a given session at the crap table.    This is possible because you are risking more 
money ($240) than you are willing to win ($80).    This means if one session lost $240, then you would 
have to win three sessions to break even.    Since this strategy has a very high WinRating it is 
considered to be a good one for the conservative player.    

It can be clearly seen that just by adjusting the Money Management numbers, the results can be 
dramaticlly different.    A good example of is can be seen in the improvement of the WinRating and 
WinGoal Rating.    The tradeoff of a higher WinRating is a decrease in expected Playtime.    Another 
point to make here is that Money Manage Assistant numbers ran for twice the total simulation Playtime
(1697 hrs.) as Conservative (816 hrs.)    This is because it takes less time to reach a Win Goal of $80 
than it does to reach a Win Goal of $215.    

It is left up to you to continue "fine-tuning" this Betting Strategy by adjusting the Money Management 
numbers to see how they will produce different results.    Keep in mind that an improvement in one 
area of the results will mean another area will get worse.    Everthing is a tradeoff and everybody is 
looking for different things in the results, so it is up to you to determine what Money Management 
numbers you like. 

RECOMMENDATION:    When objectively comparing strategies, you should compare 
results in which both Strategies have at least a "***    Good" (i.e. three star) rating for the 
accuracy of the results.    This means the Total Playtime must be at least 750 hours. 

If You Are an Aggressive Player



Recall, the Money Management Assistant helped find a "good starting point" for your Money Management 
numbers.    Let's see how to use these numbers to "fine-tune" your strategy's performance to satisfy the 
Aggressive Player.    Fine-tuning a strategy simple means modifying the Money Management numbers to 
get results to match the type of player that you are.    Remember, an aggressive player wants to risk little to 
win much (i.e. WinRating of much lower than 50%).    In order to do this, we will begin with the "good 
starting point" that the Money Management Assistant gave us:

From the StrategyMaster menu, choose Setup Bets, then choose Money Management.    The "Money 
Management" dialog box will appear. 

1. Leave the WinGoal at $215, but type in "50" in the Loss Limit box (i.e. amount you want to risk).    
This means the Aggressive Player is risking $50 to try and quadruple his money to $215.    Click OK. 
This will take you back to the IGS crap table.

2. Click on the Reset button located below the IGS crap table, then click on the Run button.    CASINO 
PLANNER will shrink down to an icon for maximum speed.

OBSERVATION:    Your results from the previous run are not saved with your strategy 
and are cleared when you hit the Reset button, run StrategyMaster again or you select the 
File menu and choose New or Open.    If you want to save the results first, you must print
then on your printer.

3. StrategyMaster will stay iconized until all 1000 sessions of the simulation are completed.    As soon as 
the simulation is complete, you will see a small pop-up window appear saying, "StrategyMaster is 
Finished!". 

4. Click OK.    You will see the Overall Results window appear with similar results to the one shown 
below:
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Notice the Accuracy of the Results is " ** Fair".    This is because the total Playtime for the simulation 
was only 449 hours.    IGS recommends comparing results only when they have an accuracy rating of at 
least three stars (i.e. *** Good).    To add more Playtime to the simulation is very simple.    From the 
Options menu, choose StrategyMaster.    Change the "Number of Sessions per Run" from 1000 to 
2000.    Click OK.    This will take you back to the IGS crap table.

5. Click on the Reset button located in the Control Panel below the IGS Crap table, then click on the Run 
button.    CASINO PLANNER will shrink down to an icon again for maximum speed.    As soon as the 
simulation is complete, you will see a small pop-up window appear saying, "StrategyMaster is 
Finished!". 

4. Click OK.    You will see the Overall Results window appear with similar results to the one shown 
below:
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Now the Accuracy of the results is " *** Good".    Notice that by lowering the Loss Limit from $240 to $50,
you are risking $50 to win $215.    If you were going to play this strategy at a real crap table, now you know
that if you want to quadruple your money, you will have a 20% chance or one out of every five sessions at 
the table.    Another point to make about this strategy is that it has an expected Playtime of only 30 minutes. 
Since this strategy has a very high chance of losing (80%), yet has the possibility of high return for the 
money at risk, it is considered to be a good strategy for the Aggressive Player.

If You Want a Minimum Amount of Playtime
Unlike the previous three runs, you do not need the Money Management Assistant numbers to help you.    
You will see how to find the Money Management numbers that will allow you to play your Betting Strategy
for a minimum amount of time.    This method is also good if you are Junket Player.    A Junket Player is 
basically someone who has agreed, in advance, to play for a minimum number of hours (i.e. 8, 10, 12 hrs. 
etc.) in return for comps such as reduced air fare, hotel accommodations, food, show tickets and so on.    
But if you are going to play for 8 hours over the course of your stay at the hotel, how do you know what 



your Money Management numbers should be?    The answer is very simple.    

Setting Up the Strategy
1. From the File menu, choose New.    The "Money Management" dialog box will appear.

In the Strategy Description box, type "$10 Pass w/double Odds".    In the Win Goal and Loss Limit 
boxes type in "1000000" for each.    This will prevent your strategy from ever reaching a Win Goal or 
Loss Limit and thus allow every session to hit the Time Limit during the StrategyMaster run.    In the 
Time Limit box, type in 8 hours.    Click OK.    This will take you back to the IGS crap table.

2. Let's use a more direct way to bring up the "Make A Bet" dialog box.    Hold down the CNTRL key and
click with the left mouse button on the upper 50% area of the Pass Line (the lower 50% is for Free 
Odds).    The "Make A Bet on the Pass Line" dialog box will appear. 

Type in a Fixed Bet amount of $10.    

3. Click on the Free Odds button.    The "Make A Bet on the Pass Line Odds" dialog box will appear.    
Select "double odds" for when the point is "4 or 10" and "5 or 9" and    "6 or 8".    Your Free Odds bet 
will be $20 no matter what the point is.    Click OK.    This will take you back to the "Make A Bet on 
the Pass Line" dialog box. Click OK.    This will take you back to the IGS crap table.

4. Next, you must setup the total number of sessions that you want StrategyMaster to simulate.    It is 
from these simulations that StrategyMaster will tally the results for your Strategy.

From the Options menu, choose StrategyMaster.    The "StrategyMaster Options" dialog box will 
appear.    Type in 1000 for the Number of Sessions.    Make sure that Heavy CPU usage, Minimize 
while running, Restore When Completed and Firm Win Goal/Loss Limit are selected as shown.

Click OK. This will take you back to the IGS crap table.

Running StrategyMaster to Get The Results
1. Click on the Run button.    CASINO PLANNER will shrink down to an icon for maximum speed.    As 

soon as the simulation is complete, you will see a small pop-up window appear saying, 
"StrategyMaster is Finished!". 

2. Click OK.    You will see the Overall Results window appear with similar results to the one shown 
below
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Understanding the Results
Let's see how to interpret the results for the Fundamental Five.    

a. The WinRating is 47.6% +/-5pts.    This means that you can expect to win    (some amount geater 
than $0) about 47% of your sessions at the table, or in other words, you can expect to win about 5 
out of every 10 sessions you play.

b. The WinGoal Rating is 0%.    (This value has no meaning for this type of simulation.)
c. The Avg. Playtime and Avg. Net-per-Session should always be looked at together. With this 

strategy, your session will last 8 hrs. and during this time you can expect your session to cost you an
average of $28.    

d. The VigRating is 0.43%.    Since the Pass Line w/double odds was the only bet, we know the ideal 
value is 0.61%.    StrategyMaster was close enough considering only 1000 sessions were simulated.

Let's see how to interpret the results for the Highs and Lows. 
a. The "Most ever AHEAD" for a given session was $1666.    There are two points to make about this

number. One, do not expect to win more than this amount over the 8 hours of play.    Two, you can 
use this number to help determine what might be a realistic Win Goal for this Betting Strategy.    In 
other words, you can pick a number much less than this amount for your Win Goal. 



b The "Most ever DOWN" for a given session was $1800.    This number is important because it 
indicates what the "worst case" amount of money you will need to play your Betting Strategy.    Can
you afford to lose this amount of money?

Let's see how to interpret the results for the Averages. 
a. Averages Winning Sessions.    When a session ended and you didn't lose, this is the amount of 

money you can expect to win and how long you can expect it will take.    In this case when a session
won, you walked away after an hour period with an average of $353.

b. Averages Losing Sessions.    When a session ended and you didn't win, this is the amount of money
you can expect to lose and how long you can expect it will take.    In this case when a session lost, 
you walked away after an hour period down an average of $379.

c. Average Net-per-Hour.    This is your average "cost per hour" to play your strategy.    This is a 
significant number since it is one of the primary indicators of what to expect your entertainment is 
going to cost and whether or not you can afford to play this strategy.    In this case, your can expect 
an average cost per hour of $3.56 to play this strategy.    Very good "entertainment" value.

Conclusions
Let's look and see how the Junket Player strategy performed.

Advantages:
· By not allowing the StrategyMaster to reach the Win Goal and Loss Limit, you are able to see the 

limitations of the Betting Strategy. (i.e. Since the "Most Ever Ahead" was $1666, don't expect to win 
more than this amount for 8 hours of play.    On the other hand, "Most Ever Down" was $1800, so you 
know what is a worst case Bankroll needed to play your Betting Strategy over an 8 hour period.

· The WinRating for this strategy is almost 50%.    (assuming a bankroll to cover a worst case loss of 
$1800). This means that you can expect to win 1 out of every 2 sessions.

· The average "cost per hour" to play this strategy is only $3.56.
· The VigRating is very low.

Disadvantages:
· A very high Bankroll is needed to ensure play over the entire 8 hour period. (worst-case is $1800)

It is left up to you to continue "fine-tuning" this Betting Strategy by adjusting the Money Management 
numbers to see how they will produce different results.    Keep in mind that an improvement in one area of 
the results will mean another area will got worse.    Everything is a tradeoff and everybody is looking for 
different things in the results, so it is up to you to determine what Money Management numbers you like. 

Wrapping Up 
The above examples only scratched the surface of what StrategyMaster can do.    Like a spreadsheet which 
starts as a blank sheet, it's up to you to get the most out of StartegyMaster.    There are literally countless 
strategies in the game of craps.    The first step in determining what strategy is best for you, is deciding 
exactly what results you are looking for.    Remember that what will work for you won't necessarily work 
for someone else.    This is because different strategies are designed to do different things.    Some are meant
to win more frequently, others to have bigger payoffs.    Still others are designed to give you a minimum 
amount of time at the table.    Therefore, there is no single crap strategy that is ideal for everyone.

All strategies work differently depending on which bets you are making, how much you are betting, and 
also your Money Management numbers.    Do you want to play like a high roller?    Or, do you want to play 
with the least amount of money possible?    Do you want to win big?    If you are a Junket player, you may 
want a strategy that will give you at least so many hours of playing time (like 8 or 10 hours).    No matter 
what your needs are, CASINO PLANNER    will help you find the strategy that's best for you.



File Menu
New...
Open...
Save...
Save as...
Print Setup...
View/Print Strategy...
Export...
Exit...



New...
Choosing New from the File menu will display the Money Management dialog box, since the first step in 
setting up a new strategy is Money Management.    For more information, see description for Money 
Management dialog box under the Strategy Master menu in this section.



Open...
Choosing Open from the File menu will display the File Open dialog box.    This option lets you access a 
strategy you saved earlier or one provided with CASINO PLANNER.    To recall a strategy,    look under the
Files list and notice strategy file names ending with the extension ".wc1".    Choose one by clicking on it 
with the mouse, then click OK.

If you can't find the file you are looking for, look in a different directory by selecting a new directory from 
the list under the Directories list box.    Strategies that were provided with the CASINO PLANNER will be 
located in the "c:\igscraps" directory, unless this path was changed during installation.



Save...
Choosing Save from the File menu will save the current strategy that is open.    If this is the first time you 
have saved a new file, you will see the "File Save As" dialog box.    Check that the name of your strategy 
file is correct and that you have selected the right directory (select a new directory by choosing from the list
in the "Directories" box)..    Remember that strategy filenames must end with ".wc1".    Click OK when 
done.



Save as...
Choosing Save as from the File menu will display the File Save As dialog box.    Through this dialog box 
you can save the current strategy under a different name.    The filename that you give must end with the 
extension ".wc1".    Make sure that you have selected the proper directory, or select a new directory by 
choosing from the list in the Directories list box.    Remember, CASINO PLANNER strategies are located 
under "c:\igscraps" directory, unless this path was changed during installation.    Click OK when done.



Print Setup...
Choosing Print Setup from the File menu will display the Select Printer dialog box.    Select the printer 
that you want to use listed under Printer and Port.    

Once the printer is selected press the "Print Setup" button {ewc D2HTools, D2H_256Color, 
help0049.bmp}.    This will bring up the printer dialog box that has the specific printer controls.    Make sure
the settings are correct and click OK to print.



View/Print Strategy... 
Choosing View/Print Strategy from the File menu will display the View/Print dialog box.    This option 
lets you see a summary of your Strategy.    You can also print the summary by selecting Print command 
from the menu.    When you are finished viewing the information, click Exit! from the menu.



Export... 
Choosing Export from the File menu will display the Export Sessions Results dialog box.    You can use the
Export command to send all the information contained in the Sessions Results window to an ASCII text file
so you can import it into other programs such as Microsoft® Excel and Lotus 123.    ASCII (American 
Standard for Computer Information Interchange) is a standard file format that allows different programs to 
exchange information easily.    ASCII filenames end with .txt

Export button - Selecting this button will display the Save As dialog box.    Give the file you want to save 
a name that ends with the extension ".txt".    Check that the directory path is correct.    Click OK and then 
click the Done button.

Done button - select this button to exit the Export command.

Once you input this information in    Microsoft® Excel or    Lotus 123,    you can then create graphs and 
charts to more easily evaluate your strategy's performance.    Refer to your Microsoft® Excel or    Lotus 123 
manuals for the steps necessary to import and create graphs and/or charts.



Exit...
Choosing Exit from the File menu will close the CASINO PLANNER application.



Options Menu
Mode...
General...
StrategyMaster...
Casino...
Select Player...
Sound Options



Mode...
Choosing Mode from the Options menu will display the Mode dialog box.    When using CASINO 
PLANNER, you can be in one of two modes.-- Game Mode or StrategyMaster Mode.    You can change 
from one mode to the other at any time, but this will cause a reset.    The current mode of CASINO 
PLANNER is always displayed in the Control Panel located below the IGS crap table.

Game Mode - This mode is simply meant to allow you to practice playing a strategy after you have found 
one you like from the StrategyMaster mode.    Therefore, you can play on your own as if you were at a real 
crap table for the benefit of preparing for a trip to a real casino.

DEFINITION:    Game Mode.    All bets must be made manually, one roll at a time, just 
like you would in a real casino

StrategyMaster Mode    CASINO PLANNER will automatically make ALL your bets as defined by a 
Betting Strategy that is saved in memory.    StrategyMaster can simulate up to 20,000 consecutive sessions 
in a short period of time. After a simulation is completed, StrategyMaster will tally the results and provide 
you a wide range of important information about your Strategy.    With this information you will be able to 
"fine tune" your Strategy for optimum performance (i.e. WinRating, Playtime, cost, etc.), or objectively 
compare it to other strategies.

DEFINITION:    StrategyMaster Mode.    All bets are made automatically according to a 
predefined Betting Strategy that has been entered through the convenient "Make-A-Bet" 
window.



General...
Choosing General from the Options menu will display the General dialog box.    This dialog box allows 
you to customize many different aspects of CASINO PLANNER.

When My Session Ends - This control tells CASINO PLANNER what to do with bets that are still on the 
table at the end of a simulated session.    Remember that your session will end if you reach your WinGoal, 
your Loss Limit, or your Time Limit.    When this happens,    no new bets will be made, but some bets may 
still be on the table:

1) Take down removable bets - As soon as a session ends, this selection will remove bets on the table
that do not have to wait for a "decision" (i.e. win or lose).    There are only two bets that can not be 
removed before a decision is made -- Pass and Come during a point roll.    Only after a decision is 
made on these type bets, will the session end.    

2) Play out all bets on the table -- This selection will wait for a decision (i.e. win or lose) for bets on 
the table before the session will end.    

Animation Settings - These controls allow you can adjust the speed of the action at the table.    
1) Single step though results - If this check box is active then your losing bets will be removed from 

the table first, one bet at a time, and then your winning bets will be paid off, one bet at a time - just 
like a real casino.    If this check box is not active then all losing bets will be removed and all 
winning bets will be paid off at the same exact time.    By not having this check box active will 
significantly speed up the pace of the game, however, this is not the way it happens at a real casino.

2) Roll results - This slide bar controls how fast CASINO PLANNER will cycle through the five roll 
results located just below Bankroll rail in the control panel.    If you are interested in reading these 
five results after each dice roll then you will want to select a long delay (i.e move to left).    
Otherwise, you will want this slide bar to be set at the shortest delay of    0.1.

3) Between rolls - This slide bar controls how fast CASINO PLANNER will roll the dice when Auto 
Roll button has been selected.    Normally you will want this slide bar to be set at the shortest delay 
of 1 (far right).    However, if you want to simulate a real casino which rolls the dice approximately 
every 30 seconds, you can adjust the speed accordingly.

Alarm - This control is only available in the StrategyMaster mode.    The alarm can be used to notify you 
that a StrategyMaster run is complete.    Since some runs can be long, you might not necessarily be using 
the computer.    Instead, you might be in the next room in which case you can use the alarm to notify you 
that the simulation is complete. 

1) Off - This selection will not sound the alarm when StrategyMaster is done.
2) Once - This selection will make one beep sound when StrategyMaster is done.
3) Continuos - This selection will make a continuous beeping sound when StrategyMaster is done.    

When this occurs a small window will be displayed saying, "StrategyMaster is Finished!".    Simply 
click the OK button to stop the alarm and the Overall Results window will automatically be 
displayed.

General Preferences - This control lets you choose some additional options for CASINO PLANNER.

1) Display IGS logo at startup - If this check box is active then the IGS logo will pop up each time 
you start CASINO PLANNER, otherwise, the IGS logo will not be displayed.

2) Player Animation - If this check box is active then animated players will be seen at the table in the 
lower left portion of the main screen, otherwise, no players will be shown.    It should be noted that 
if "Player Animation" is selected, the pace of the game will slow down due to the activity 
associated with the animation.

Number of players - This option is only available when "Player Animation" is selected.    It allows you to 
select the number of players at the table.    When "Player Animation" is not selected, this option will be 
grayed out.



1) I am the only player - You will be the only animated player at the table.
2) Three players at the table - This selection will display three animated players at the crap table, 

including yourself.    The dice will pass from player to player each time there is a new shooter just 
like in a real casino.

Auto-Correct Bet Amounts - This option controls whether or not you will be warned with a pop up 
window if you try to make a bet that doesn't match the correct odds.    For example, if you had made a $5 
free odds bet and the point was 5 or 9 (a payoff of 3 to 2), a winner would result in a payoff of $7.50.    
However, the casino will only pay in whole dollar amounts, so you would lose fifty cents.    In this case an 
even bet amount, such as $6, is necessary to avoid losing money.

1) Correct without prompts - This selection is for advanced players that know the correct bet 
amounts but don't want to bother with "assembling" the exact bet amount.    For example, lets say 
you wanted to Place the 6 and 8 for $6.    All you would have to do is place these bets for $5 each 
(i.e don't worry about wasting time with the extra $1) and CASINO PLANNER will automatically 
adjust the bet to $6 for you.    This option will speed up the pace of the game.

2) Correct with prompts - This selection is for beginners who may not be completely familiar with 
all the correct bet amounts on the table.    Each time an incorrect bet amount is made, a pop up 
window will appear describing what you did wrong and a suggestion how to correct it.



StrategyMaster...
Choosing StrategyMaster from the Options menu will display the StrategyMaster Options dialog box.    
This dialog box has controls that are used in the StartegyMaster mode.    

Number of Sessions Per Run - This number instructs StrategyMaster on how many sessions will be 
simulated each time StrategyMaster is run.    The maximum Number of Sessions per Run is 20,000.

Minimize while running - If this check box is active then CASINO PLANNER will shrink down to an 
icon each time StrategyMaster is run to obtain maximum speed.    This allows StrategyMaster to run a fast 
as your computer will allow.    If this check box is not active then StrategyMaster will not shrink to an icon 
each run, but instead will display the IGS crap table as it updates in real time thus allowing you to look at 
the results under the StrategyMaster menu.

Restore when completed - If this check box is active then StrategyMaster will restore the IGS crap
table when the run is completed.    If you are busy doing other activities on you computer (i.e. other 
games or applications) and don't want to immediately look at the results when a run is completed, 
then leave this check box inactive.



Casino...
Choosing Casino from the Options menu will display the Setup Casino dialog box.    Use this dialog box 
setup a casino that matches the casino you plan to visit.    You can adjust the payoff odds of various bets, 
change the color of the table, and even control the color of individual playing chips.    It is important to 
CASINO PLANNER has the same payoff odds as the casino you plan to visit, if not, the results could be 
dramatically different.    For example, your favorite casino may offer you improved odds on Proposition 
bets in which case you should adjust the payoff odds to match using this dialog.

Other important factors may vary from one casino to another.    These include the table color of the layout, 
minimum bet, and the table bet limit.    CASINO PLANNER keeps track of all this for you, and enforces 
the rules of the table just as the dealer would at that casino.

"New" Casino - Some of the most popular casinos have already been set up for you.    If the casino you 
plan to visit is not in the list, you can easily add casinos to the list as described below:

1) Click on the button called "New".    A dialog box will appear titled "Your New Casino's Filename". 
2) Type in the name for your new casino just to the right of the word "Filename".    Since this is a DOS

file, you can only have up to eight characters for the name and the filename must end with ".csr" 
(i.e. Ballys.csr).    Click OK.    This will take you back to the "Setup Casino" Dialog.

3) Notice your casino name now appears below the word "Filename.    Just to the right, type in a brief 
description of the casino (i.e. location and full name, etc.)

Now any changes that are made elsewhere in the "Setup Casino" dialog box will be saved under the new 
casino name.

Table Stakes - Type in the minimum bet and maximum bet for the crap table.

Free Odds - Select the free odds limit for the crap table. (Double odds is most common)

Proposition bets - 
1) Type - There are two different ways to express the payoff odds for proposition bets, "to" and "for".  

Let's start out with an example in which you are betting $1 on the "Any 12".    If the layout at one 
casino for the "Any 12" bet says "29 to 1", this is the same as another casino that has a layout that 
says "30 for 1".    In other words the vig is the same.    When the layout says "29 to 1", this means 
that if you win the casino will pay you $29 for your $1 bet and the casino will not collect your bet.   
However, when the layout says "30 for 1", this means that if you win the casino will pay you $30 
and collect the $1 bet, for a net win of $29.    
The person who is new to the game of craps might think "30 for 1" is better than "29 to 1", but in 
reality there is no difference at all.    Some casinos like to use "for" instead of "to" since the "for" 
payoff seems like a better payoff and thus might attract more crap players to their tables.

2) Payoff Odds - Of all the Proposition Bets, there are four bets which have payoff odds that can vary 
from casino to casino.    These include the Any 2, Any 3, Any 11(Yo) and Any 12 bets which are 
shown just to the right of the "Payoff Odds" area of this dialog. 
"Basic Odds" refers to what most casinos would have for there payoff odds on these four bets (i.e. 
Any 12 payoff is 29 to 1).    
"Improved odds" refers to casinos that give slightly better payoff odds on these four bets in order to 
attract more players to their casino (i.e. Any 12 payoff is 30 to 1).    
"Custom Odds" can be used in cases where the casino you plan to visit has neither basic nor 
improved odds.    There are a few casinos that offer even better payoff odds than "Improved odds" 
(i.e. Any 12 payoff is 31 to 1).    In this case you can select "Custom" and type in the free odds 
without any restrictions.

3) Field - The Field bet payoff    for the 2 and 12 can vary from casino to casino.    Therefore, select 
single, double or triple odds to match the casino you plan to visit.    

4) Rolls per hour - There are approximately 120 rolls of the dice each hour.    A busy table might have



slightly less, a non-busy table might have slightly more.    In a real casino, several moments (even 
minutes) may pass between dice rolls.    However, the average time is about thirty seconds.    This 
equates to    about two rolls per minute or 120 rolls per hour (2 rolls/min multiplied by 60 min/hr).    
The number of rolls per hour can not be perfect.    What does matter is that when comparing 
strategies, you keep the "Rolls per hour" the same.    You probably will never need to adjust this 
parameter, but if you want the capability to adjust this number, you can.

RECOMMENDATION:    It is strongly advised that you leave the rolls per hour at 120.    
5) Layout Color - Table color for the layout can vary.    The most popular layout color is green, with 

some casinos using blue.    The gray table is not used by casinos but it is very practical for CASINO
PLANNER since the chip colors are easier to see, and there are different shades of gray to help you 
identify unlabeled bets.

6) Chip colors - Chip colors can vary from casino to casino.    However, the most popular chip colors 
are defined as follows:    White = $1, Red = $5, Green = $25 and Black = $100.    You can change 
the chip colors as follows:
Under "Chip Colors," select the chip whose color you wish to change by clicking the dollar amount 
button.
To learn more about the different options that are available, refer to the picture below.    Move the 
cursor over the picture.    When the cursor becomes a hand, click to get information on that part of 
the picture.
Choose from a list of "Basic Colors":
Choose any color on the list.    These colors cannot be changed.    To select a custom color, see 
Choose from a list of "Custom Colors.

Choose from a list of "Custom Colors":

How to Create a New Custom Color
Only 16 colors can be on the list at any one time.    To create a new color, you must replace an 
existing color.    To create a NEW Custom Color:



Color Refiner Box
The Color Refiner Box is used to select a new Custom Color.

Color|Solid Box
When you pick a color by dragging the cursor inside the Color Refiner Box, the color selected 
appears inside the left half of the Color|Solid Box.

Luminosity Bar

Hue,Sat,Lum Boxes



You can specify a color by typing numbers in the "Hue," "Sat," and "Lum" (Luminosity) boxes.    
This also allows you to exactly match a specific color.    For example, if you like a particular color 
in a certain graphic file, you can use your paint program to identify the HSL components of that 
color.    By typing these same numbers here, you will create an exact match of the color in the 
graphic file.
Red,Green,Blue Boxes
You can specify a color by typing numbers in the "Red," "Green," and "Blue" boxes.    This also 
allows you to exactly match a specific color.    For example, if you like a particular color in a certain
graphic file, you can use your paint program to identify the RGB components of that color.    By 
typing these same numbers here, you will create an exact match of the color in the graphic file.
Add to Custom Colors
This button is used to add a NEW color to the list of Custom Colors.



Select Player...
Choosing Select Player from the Options menu will display the "Select a Player to represent yourself" 
dialog box.    There are 12 animated players included with CASINO PLANNER, each with their own 
personality and mannerisms.    Choose the one you want to represent yourself by clicking in the box next a 
character's name.    CASINO PLANNER will pick the other players at random and display them at the 
table.    



Sound Options
Choosing Sound Options from the Options menu will display the Sound Options dialog box.    CASINO 
PLANNER allows you to "turn on" the type of sounds you want to hear and "turn off" the ones you don't.    
You can have real casino sounds as well as music playing in the background.    Many MIDI (music) files 
come with the software, or you can use your own.

Speech - If this check box is active, you will hear the stickman call the outcome of each roll, and you will 
also hear a voice when a warning dialog box pops up.    If this check box is not active, these sounds will not
be heard.

Sound Effects - If this check box is active, you will hear the dice as they are rolled and the sound of bets as
they are placed and taken away. If this check box is not active, these sounds will not be heard.    The 
computer can payoff and remove bets faster than your eye can see.    Therefore, CASINO PLANNER has 
two convenient sounds that will indicate whether you won or lost money for your for a given roll of the 
dice.    If you net for a dice roll wins money, you will hear a bell sound.    If your net for a dice roll loses 
money, you will hear a "cash register" sound.

Crowd Sounds - If this check box is active, you will hear casino background sounds.    You will even hear 
crowd sounds and slot machines in the background to experience the feel of a real casino.    If this check 
box is not active, these sounds will not be heard.    

Music - Most casinos play music that can be heard from speakers located in the ceiling.    If this check box 
is active, ten music selections will play in sequence in the background just like a jukebox.    These 
selections are MIDI files listed under the "Music Files" list box.

1) Music Files - This shows a list of ten MIDI files that will be cycled through, just like a jukebox.    
CASINO PLANNER includes two MIDI files which make up the list of ten files.    You aren't 
limited to using only those MIDI files provided with the software.    If you have your own MIDI 
files, you can play these too.    Just remember, ten files must be on the play list at all times.    You 
can replace an item on the list, but you cannot add or delete any items.    To replace a music file on 
the list:

a.    Click once on the filename with the mouse.    A "Select a MIDI file" window will appear.    

b.    Use the "Directories" list box to locate the MIDI file you are interested in.    As you change a 
directory, you will see any ".mid" files listed under the "Files" list box.    You may only select 
filenames that end with ".mid."

c.    Once the MIDI file you want appears under the "Files" list box, click once on the file to select 
it and then click OK to return back to the Sound Options dialog.    You will now see the new 
MIDI file in place of the previous one that you selected.    Click OK to return back to the IGS 
crap table.



StrategyMaster Menu
Setup Strategy...Money Management
Setup Strategy...Bets
Run...Go
Run...Reset
Results...Overall
Results...Each Session
Results...Bankroll Graph
Results...Shooter



Setup Strategy...Money Management
Choosing Setup Strategy...Money Management from the StrategyMaster menu will display the Money 
Management dialog box.    Money Management plays a vital role in planning a winning trip to the casino.    
It is only by the proper use of Money Management that you can actually have a better than 50% chance in 
beating the casino on your next trip.    In other words, if you are willing to risk more money than you are 
willing to win (i.e. Loss Limit is greater than Win Goal), you can easily have WinRatings of greater than 
50%.

Strategy Description - Type in meaningful name to keep track of your strategy since filenames are limited 
to the DOS standard of 8 characters in length.    This description appears in the in the title bar of IGS crap 
table window.    To enter a description.

Win Goal - Type in the amount of money you would like to win while playing your Betting Strategy.

Loss Limit - Type in the amount of money you are willing to risk in order to obtain your Win Goal. 

Bankroll - CASINO PLANNER automatically controls this amount and is always twice your Loss Limit or
$500, which ever is greater.

Time Limit - If you don't reach your Win Goal or Loss Limit, you need to limit the amount of time you 
spend at the table.    Your Time Limit is the maximum period of time that that you are willing to play your 
Betting Strategy in order to obtain your Win Goal.

Filename - The first time you save your Strategy, you will be prompted to give your Strategy a filename.    
This filename will be shown in this dialog.

Money Management Assistant - For a given Betting Strategy, the Money Management Assistant will 
automatically give you a "good starting point" for a realistic Win Goal, Loss Limit and Bankroll needed to 
play your strategy.    

For more information, see How to Use the "Money Management Assistant How to Use the "Money 
Management Assistant .



Setup Strategy...Bets
Choosing Setup Strategy...Bets from the StrategyMaster menu will display the Betting Strategy dialog 
box.    Through this dialog box you can enter your Betting Strategy.    You can also open this dialog box by 
clicking once on the "Betting Strategy" button located in the Control Panel below the IGS crap table.    

Forty-five possible crap bets are listed, each having a corresponding check box.    You can scan this dialog 
box quickly for active check boxes to see which bets are used by your Betting Strategy.    Click on any 
check box to open the Make A Bet dialog box.    This is where you define the specific details of a bet, such 
as when to make the bet and for how much.    The Make A Bet dialog box is virtually the same for every 
crap bet on the table.    Therefore, once you have learned how to use it, you can enter other bets the same 
way.

SHORTCUT:    To directly open the Make A Bet dialog box for a particular bet, move the 
cursor over the IGS crap table, hold down the CNTRL key and click on the layout with 
the left mouse button.

RULE:    Anytime the OK button is selected, StrategyMaster will assume that a change 
has been made to your Betting Strategy and therefore perform a reset.    Any results that 
may have been stored will be lost.    If you have not made changes (i.e. you were just 
checking your bet amount, etc.) and do not wish StrategyMaster to reset, use Cancel 
instead of OK to close the window.

Current Odds - This defines the True odds, Payoff odds, and Vigorish for this particular bet.    Some True 
odds are expressed as    * to *    and means the true odds for this bet can not be expressed easily with two 
numbers.)

Current Bet - This box shows the amount of this bet (if any) that was on the table at the time the Make A 
Bet dialog box was opened.

Fixed Bet - Enter a bet amount    in this box if you want a fixed bet amount to be made for each new crap 
game.    You can type a dollar amount in this box or use one of the shortcut buttons.    The text "Fixed Bet" 
changes to "Initial Bet" when the Bet Sequencer is being used.    The Bet Sequencer is described in detail in 
Appendix A.

Computer-Controlled Bet - If this check box is selected then any bets and controls associated with this 
particular Make A Bet dialog box will be executed by StrategyMaster.    If this check box is not selected 
then any bets and controls associated with this particular Make A Bet dialog box will stay setup the way 
they are, except that all information in this dialog box will be ignored by StrategyMaster.    This avoids the 
hassle of going into the dialog box and typing in zero dollar amounts everywhere to disable the bet.    Use 
this control as a quick way to disable a bet when using StrategyMaster.

Conditional Betting - This control defines when StrategyMaster will make a particular bet.
1) All Rolls - This selection will make the bet every roll of the dice (i.e. both Comeout and Points 

rolls).
2) Comeout Rolls Only - This selection will make the bet only on Comeout rolls, not Point rolls.
3) Point Rolls Only - This selection will make the bet only on Point rolls.    You must also indicate 

which Point numbers this bet will be active by selecting the check box above the desired Point 
number.

Free Odds button - You can use the Free Odds button to open the Free Odds dialog box.    You have great 
flexibility in setting up your free odds bets when making a Pass, Don't Pass, Come or Don't Come bets.    
For each established Point. there are five selections to choose from:

1) No odds - No free odds bets will be made
2) Single odds - StrategyMaster automatically calculates your single odds bet.
3) Double odds - StrategyMaster automatically calculates your double odds bet.
4) Triple odds - StrategyMaster automatically calculates your triple odds bet.



5) Custom odds - You manually type in any free odds amount you want.

Bet Sequencer button - You can use the Bet Sequencer button to open the Bet Sequencer dialog box.    
Through this dialog box you can define a winning and/or losing sequence for your bet.    For more 
information, see Appendix.

NOTE:    The Bet Sequencer is an advanced feature of CASINO PLANNER.    It is not 
recommended to use this feature until you are comfortable using "Fixed bets" with 
StrategyMaster.



Run...Go
Choosing Run...Go from the StrategyMaster menu will cause StrategyMaster to simulate a predefined 
number of sessions based a Strategy that has been entered.    



Run...Reset
Choosing Run...Reset from the StrategyMaster menu will cause StrategyMaster to prematurely abort the 
current simulation.



Results...Overall
Choosing Results...Overall from the StrategyMaster menu will display the Overall Results window.    
This window provides a wide range of important information about your Strategy.    This window will 
appear after every StrategyMaster run or if you don't want to wait to see the results, you can look at this 
window during the middle of a simulation run.    The window is partitioned into four main groups to make it
easy to understand your Strategy's performance:

1) The Fundamental Five
2)    Highs and Lows
3)    Averages
4)    Totals

The Fundamental Five
Definition:    Fundamental Five.    A summary of vital information about a Strategy that 
characterizes its performance, and thus, allows for quick and easy comparison between 
strategies.    Also, the Fundamental Five provides practical information that you need to 
know when going to a real casino.

The Fundamental Five includes the following:
1) Your actual chances of winning (your    WinRating™.)
2) Your chances of achieving your    Win Goal (your WinGoal Rating™).
3) Your Average Playtime at the table.
4) Your Average NET-per-Session at the table.
5) The VigRating or House Percentage    for your entire Strategy.

Fundamental Five Item #1:    The WinRating - While using a particular Strategy, the WinRating indicates
what your chances of winning are at the time your session ends.    The WinRating is expressed in terms of 
percent.    If a Strategy has a WinRating of 70%, then you would have a 70% chance of walking away from 
the table with more money than you started with.

Fundamental Five Item #2:    WinGoal Rating - For a given session at the table, the WinGoal Rating 
indicates what your chances are of reaching a predetermined Win Goal amount while using a particular 
Strategy.    The WinGoal Rating is expressed in terms of percent.    If a Strategy has a WinGoal Rating of 
75%, then you would have a 75% chance of walking away from the table with your Win Goal amount. 

The difference between the WinRating and WinGoal Rating:
1) WinRating - refers to winning any amount of money at the time a session ends.
2) WinGoal Rating - refers to winning a predetermined Win Goal amount at the time a session ends.

OBSERVATION:    The WinRating will be greater than the WinGoal Rating if at least one
winning session ends by reaching its Time Limit.

OBSERVATION:    The WinRating will be equal to the WinGoal Rating if every winning 
session ends before reaching its Time Limit.

Fundamental Five Item #3:    Average Playtime - The "Average Playtime" indicates how long you can 
expect a session to last while using a particular Strategy.    The actual Playtime for any one session can vary 
greatly from session-to-session.    Therefore, the Average Playtime is useful for objectively comparing one 
strategy to another.

Fundamental Five Item #4:    Average NET-Per-Session -The "Average Net-per-Session " indicates how 
much money you can expect a session to cost while using a particular Strategy.    The actual cost for any one
session can vary greatly from session-to-session.    Therefore, the Average Net-per-Session is useful for 
objectively comparing one strategy to another.    



Fundamental Five Item #5: The VigRating - The VigRating is the advantage that the casino has over the 
player for an entire Betting Strategy.    It is a measure of how fast you can expect to lose your money based 
on the total amount of money bet while playing a certain Betting Strategy.    (See Appendix F)

Highs and Lows
Most Ever Ahead - The most you were ever ahead for a given session during the StrategyMaster run. 

Most Ever Down - The most you ever down for a given session during the StrategyMaster run. 

Playtime Winning Session (Min./Max.) - For all sessions that ended in a win, this is the range of 
Playtime. 

Playtime Losing Session (Min./Max.) - For all sessions that ended in a loss, this is the range of Playtime. 

Averages
Winning Sessions ($) - Average amount of money won when a session ended in a win.

Winning Sessions (Hrs:Min) - Average Playtime when a session ended in a win.

Losing Sessions ($) - Average amount of money lost when a session ended in a loss.

Losing Sessions (Hrs:Min) - Average Playtime when a session ended in a loss.

NET-per-Hour - The amount of money you can expect to lose, over time, for every hour    that a particular 
Betting Strategy is played.    (i.e. NET-per-Hour = "expected cost")

Totals
# Winning Sessions - Number of sessions that won out of total number of sessions simulated.

Sessions Completed - Total sessions have been currently run.

% Sessions Completed - The percent of how many sessions have been completed.

Total Dice Rolls - Number of dice rolls that were made for all sessions simulated.

Dice Accuracy - The accuracy of the dice rolls from there ideal value.

Total Winnings - A cumulative total of all money won when a session ended in a win.

Total Money Bet - A cumulative amount of all money bet for all sessions simulated..

Total Markers Taken - The number of markers that were taken for all sessions simulated.

NET (Total Ahead/Down) - The cumulative amount of money won and lost for all sessions simulated.

Total PLAYTIME - Total playtime for all sessions simulated.



Results...Each Session
Choosing Results...Each Session from the StrategyMaster menu will display the Sessions Results 
window.    This window shows you more detail as to what actually happened during the StrategyMaster run.
This scrolling window contains session-by-session accounting of what occurred during the StrategyMaster 
simulation.    Any one of these sessions could represent your next session at a real casino.    You can view 
this information after the StrategyMaster run is completed, or see it update while the run is in progress.    
You can scroll and view up 20,000 sessions.    

{ewc D2HTools, D2H_256Color, help0057.bmp}

The summary bar at the top of the window gives you running totals for the column below.    Below the 
summary bar, are the results for each individual session that was simulated.

"Ses #" Column - This column shows, in ascending order, the session number for each of the individual 
sessions as it was simulated by StrategyMaster.    If you view this window in the middle of a run then this 
number will increase until the run is finished.    

"Result" Column - This column indicates how your session ended.    The WinRating is shown at the top of
the    "Result" column and is based on the total number of winning sessions.

1) "T/L" = Time limit reached, Lost your session
2) "T/W" = Time limit reached, Won your session
3) "T/E" = Time limit reached, you broke Even
4) "W/W" = WinGoal reached, Won your session
5) "L/L" = Loss limit reached, Lost your session

"Rolls" Column - This column shows the number of dice rolls made during each session.    

"Hr:Min" Column - This column shows the elapsed play time to complete each session. 

"Low" Column - This column shows the "Most ever DOWN" during that session.    This column is used to
determine the "Most ever DOWN" number in the "Highs and Lows" part of the Overall Results window.

"High" Column - This column shows the "Most ever AHEAD" during that session.    This column is used 
to determine the "Most ever AHEAD" number in the "Highs and Lows" part of the "StrategyMaster 
Results" window.

"Net" Column - This column shows the amount of money you won or lost at the end of each session.

"Sum Net" Column - This column shows the cumulative win/loss as each session was completed.    In 
other words, this is a running total of how much you have won or lost so far during the course of the 
StrategyMaster run.    "Overall Net" at the top of this column indicates the cumulative total amount you 
won/lost for the entire run.

"Dice Acu" Column - This column indicates how accurate the dice rolls were compared to their ideal 
value during a particular session.    Since the number of rolls for any given session is not that high, do not 
expect the dice accuracy to be very good.



Results...Bankroll Graph
Choosing Results...Bankroll Graph from the StrategyMaster menu will display the Session Bankroll 
History graph.    This is a graph of your money during the current session of the StrategyMaster run.    
Sometimes it is more helpful to see a picture rather than a bunch of numbers.

If the black line is above the blue dotted line, you are ahead.    If the black line is below the blue dotted line,
you are down.    The closer the black line is to the green dotted line, the closer you are to reaching your Win
Goal.    The closer the black line is to the red dotted line, the closer you are to hitting your Loss Limit.    You
can re-size and move this window anywhere you find convenient.



Results...Shooter
Choosing Results...Shooter from the StrategyMaster menu will display the Shooter Statistics window.    
This feature lets you keep track of how all shooters are doing during the simulation.    This helps you decide
when to bet on other shooters while in the Game mode.

Use the arrow buttons to select a shooter.    The shooter's name and picture are displayed (the picture is only
displayed if the Player Animation view is currently turned ON).    All information in this window is valid 
for the current session only.    StrategyMaster does not track Shooter Statistics from one session to another.   
Also, turning the Player Animation ON or OFF will reset the shooter statistics but will not reset the 
StrategyMaster results.



Introduction
The following contains a description of three strategies that are included with the mini version of CASINO 
PLANNER for Craps.    Remember, strategies provided with this program are just a SAMPLE of what the 
software can do for you. To unleash the full power of CASINO PLANNER you need to create your own.

(Note: Confusion can happen when literally 100's or even 1,000's of strategies are created and saved with 
CASINO PLANNER.    In an effort to reduce the confusion, a naming convention was created.    Strategies 
are categorized by the BASIC type of bet used by the strategy.    The remaining characters are numbered 
sequentially as systems are created in a category.    The WC1 extension stands for Windows Craps 1.)



Strategies
PASS0001.WC1

Money Management:    Win Goal = $20;    Loss Limit = $40;    Time Limit = 3 Hrs.
Betting Strategy:    $5 Pass

This strategy is good for the player who is new to the game.    Master the Pass line 
first before trying other advanced strategies.

PASS0002.WC1
Money Management:    Win Goal = $75;    Loss Limit = $150;    Time Limit = 3 Hrs.
Betting Strategy:    $5 Pass w/double odds

This is the simple Pass Line strategy with double odds.    
PASS0003.WC1

Money Management:    Win Goal = $75;    Loss Limit = $150;    Time Limit = 3 Hrs.

Betting Strategy:    $5 Pass, using IF I WIN Bet Sequencer
This strategy uses the Bet Sequencer. If the Pass Line bet wins, press bet one unit 
(in this case $5). If Pass bet reaches $45 then stay at $45. Whenever the Pass Line 
bet loses, return back to initial bet of $5.



Bets
CASINO PLANNER supports dozens of different craps bets and enforces the rules for each bet, just like 
the dealer would do at the casino.    There are times when you are interested in the certain aspects of a 
particular bet (i.e. you forgot payoff odds).    Help for all the bets on the IGS crap table is just a mouse click
away.    

RECOMMENDATION:    Hold down the SHIFT key and click with the left mouse button
on the IGS crap table for instant On-line Help for the bet you are interested in.

Help information on a specific crap bet includes definition, true odds, payoff odds, house advantage, 
decision, and vigorish.    When you are done with the help, go to the File menu and choose Exit.



Any Seven
Description:

The Any Seven bet is a one-roll bet that can be made at any time during the game.

Decision:
WINS if a 7 is rolled.
LOSES if anything other number is rolled.

Payoff:
True odds = 5 to 1
Payoff = 4 to 1
Vigorish = 16.67%



Any Craps
Description:

The Any Craps bet is a one-roll bet that can be made at any time during the game. 

Decision:
WINS if a either 2,3 or 12 is rolled.
LOSES if anything else is rolled.

Payoff:
True odds = 8 to 1
Payoff = 7 to 1
Vigorish = 11.11%



Any 2
Description:

The Any 2 bet is a one-roll bet that can be made at any time during the game.    The payoff depends on 
settings in the "Set Up Casino" window (to access this window, select "Options" and then "Casino").

Decision:
WINS if a 2 is rolled.
LOSES if anything else is rolled.

Payoff: (Odds = "Basic"):
True odds =    35 to 1
Payoff = 29 to 1
Vigorish =    16.67%

Payoff: (Odds = "Improved"):
True odds = 35 to 1
Payoff = 30 to 1
Vigorish =  13.89%



Any 3
Description:

The Any 3 bet is a one-roll bets that can be made at any time during the game.    The payoff depends on 
settings in the "Set Up Casino" window (to access this window, select "Options" and then "Casino").

Decision:
WINS if a 3 is rolled.
LOSES if anything else is rolled.

Payoff: (Odds = "Basic"):
True odds =    17 to 1
Payoff = 14 to 1
Vigorish =    16.67%

Payoff: (Odds = "Improved"):
True odds = 17 to 1
Payoff = 15 to 1
Vigorish =  11.11%



Any 12
Description:

The Any 12 bet is a one-roll bet that can be made at any time during the game.    The payoff depends on 
settings in the "Set Up Casino" window (to access this window, select "Options" and then "Casino").

Decision:
WINS if a 12 is rolled.
LOSES if anything else is rolled.

Payoff: (Odds = "Basic"):
True odds =    35 to 1
Payoff = 29 to 1
Vigorish =    16.67%

Payoff: (Odds = "Improved"):
True odds = 35 to 1
Payoff = 30 to 1
Vigorish =  13.89%



Any 11 (Yo)
Description:

The Any 11 (YO) bet is a one-roll bet that can be made at any time during the game.    The payoff depends 
on settings in the "Set Up Casino" window (to access this window, select "Options" and then "Casino").

Decision:
WINS if a 3 is rolled.
LOSES if anything else is rolled.

Payoff: (Odds = "Basic"):
True odds =    17 to 1
Payoff = 14 to 1
Vigorish =    16.67%

Payoff: (Odds = "Improved"):
True odds = 17 to 1
Payoff = 15 to 1
Vigorish =  11.11%



Horn
Description:

The Horn Bet is a one roll bet that can be made at any time during the game.    It consists of the Any 3, Any 
2, Any 12, and Any 11 all at same time



Hardway 4
Description:

The Hardway 4 bet is multiple-roll bet and can be made and removed at any time during the game.

Decision:
WINS if a 2 appears on BOTH DICE (2 + 2 = 4, the "hard way").
LOSES if a 7 is rolled and also if 4 is rolled the "easy way" (3 + 1).
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 8 to 1
Payoff = 7 to 1
Vigorish = 11.11%



Hardway 6
Description:

The Hardway 6 bet is multiple-roll bet and can be made and removed at any time during the game.

Decision:
WINS if a 3 appears on BOTH DICE (3 + 3 = 6, the "hard way").
LOSES if a 7 is rolled and also if 6 is rolled the "easy way" (4 + 2 or 5 + 1).
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 10 to 1
Payoff = 9 to 1
Vigorish = 9.09%



Hardway 8
Description:

The Hardway 8 bet is multiple-roll bet and can be made and removed at any time during the game.

Decision:
WINS if a 4 appears on BOTH DICE (4 + 4 = 8, the "hard way").
LOSES if a 7 is rolled and also if 8 is rolled the "easy way" (2 + 6 or 3 + 5).
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 10 to 1
Payoff = 9 to 1
Vigorish = 9.09%



Hardway 10
Description:

The Hardway 10 bet is multiple-roll bet and can be made and removed at any time during the game.

Decision:
WINS if a 5 appears on BOTH DICE (5 + 5 = 10, the "hard way").
LOSES if a 7 is rolled and also if 10 is rolled the "easy way" (6 + 4).
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 8 to 1
Payoff = 7 to 1
Vigorish = 11.11%



Pass Line
Description:

The Pass Line bet is an easy multi-roll bet that can only be made on a Comeout roll (the first roll of a new 
game).

Decision:

On the Comeout roll (bet is removable):
WINS if a 7 or 11 is rolled.
LOSES if a 2, 3, or 12 is rolled.
If 4, 5, 6, 8, 9 or 10 is rolled, a Point is established and nothing happens to your money.    The next roll 

will be a Point roll.

On the Point roll (bet is NOT removable):
WINS if the point number is repeated.
LOSES if a 7 is rolled.
Otherwise, no decision is made and the next roll will be a Point roll.

Payoff:
Payoff = 1 to 1
Vigorish = 1.41%



Pass Line Free Odds
Description:

This bet can only be made in conjunction with a Pass Line bet and only during a Point roll.    Free odds bets 
may be reduced or removed at any time during any Point roll.

Decision:
WINS if the point is repeated 
LOSES if a 7 is rolled.

Payoff:
POINT # True Odds Payoff Vigorish

6 or 8 6 to 5 6 to 5 0.0%
5 or 9 3 to 2 3 to 2 0.0%

4 or 10 2 to 1 2 to 1 0.0%

Don't Pass
Description:

The Don't Pass bet is the opposite of the Pass Line bet and can only be made on a Comeout roll (the first 
roll of a new game).

Decision:

On the Comeout roll (bet is NOT removable):
WINS if a 2 or 3 is rolled.
LOSES if a 7 or 11 is rolled.
If 4, 5, 6, 8, 9 or 10 is rolled, a Point is established and nothing happens to your money.    The next roll 

will be a Point roll.
If a 12 is rolled, it is a push and nothing happens to your money.

On the Point roll (bet is removable):
WINS if a 7 is rolled.
LOSES if the Point number is repeated.
Otherwise, no decision is made and the next roll will be a Point roll.

Payoff:
Payoff = 1 to 1
Vigorish = 1.40%



Don't Pass Free Odds
Description:

This bet can only be made in conjunction with a Pass Line bet and only during a Point roll.    Free odds bets 
may be reduced or removed at any time during any Point roll.    This bet can only be made in conjunction 
with a Don't Pass bet and only during a Point roll.    Free odds bet may be reduced or removed at any time 
during any Point roll.

Decision:
WINS if if a 7 is rolled
LOSES if the Point number is repeated.

Payoff:
POINT # True Odds Payoff Vigorish

6 or 8 5 to 6 5 to 6 0.0%
5 or 9 2 to 3 2 to 3 0.0%

4 or 10 1 to 2 1 to 2 0.0%

Come
Description:

The Come bet is identical to the Pass Line bet (same payoff and Vigorish) but is made on a Point roll rather 
than a Comeout roll.

Example:

Let's suppose that a Point has been established and the Point number is 4.    Since it is a Point roll, you can 
make a Come bet by placing chips on the "Come" portion of the layout.    Now, even though it is still a 
Point roll (the Point is 4),    the next roll of the dice is considered the "Comeout" for your Come bet:

 WIN if a 7 is rolled
LOSE if a 2, 3 or 12 is rolled.

 If a 4, 5, 6, 8, 9 or 10 is rolled, it becomes the Come Point (a Point for your Come bet only); your 
chips are moved to a place next to this Point number.

If a Point is established for your Come bet, in order to WIN you must now roll this Point number again 
BEFORE rolling a 7.



Come Free Odds
Description:

This bet can only be made in conjunction with a Come bet, and it can only be made after this Come bet has 
established its point.    Free odds bets may be reduced or removed at any time.

Decision:

This bet WINS if the Come bet's point is repeated and LOSES if a 7 is rolled.

Payoff:
POINT # True Odds Payoff Vigorish

6 or 8 6 to 5 6 to 5 0.0%
5 or 9 3 to 2 3 to 2 0.0%

4 or 10 2 to 1 2 to 1 0.0%

Don't Come
Description:

The Come bet is identical to the Don't Pass bet (same payoff and Vigorish) but is made on a Point roll 
rather than a Comeout roll.

Example:

Let's suppose that a Point has been established and the Point number is 4.    Since it is a Point roll, you can 
make a Don't Come bet by placing chips on the "Don't Come" portion of the layout.

Now, even though it is still a Point roll (the Point is 4),    the next roll of the dice is considered the 
"Comeout" for your Don't Come bet:

 WIN if a    2 or 3, is rolled
 LOSE if a 7 or 11 is rolled.

 If a 4, 5, 6, 8, 9 or 10 is rolled, it becomes the Don't Come Point (a Point for your Don't Come bet 
only); your chips are moved to a place next to this Point number.

If a Point is established for your Don't Come bet, in order to WIN you must now roll a 7 BEFORE rolling 
this Point number again.



Don't Come Free Odds
Description:

This bet can only be made in conjunction with a Don't Come bet, and it can only be made after this Come 
bet has established its point.    Free odds bets may be reduced or removed at any time.

Decision:
WINS if the Don't Come bet's point is repeated.
LOSES if a 7 is rolled.

Payoff:
POINT # True Odds Payoff Vigorish

6 or 8 5 to 6 5 to 6 0.0%
5 or 9 2 to 3 2 to 3 0.0%

4 or 10 1 to 2 1 to 2 0.0%

Place 4
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.    Due to the payoff 
odds, you must be able to divide your bet amount evenly by 5 (5, 10, 15, 20, etc.).

Decision:
WINS if a 4 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 2 to 1
Payoff = 9 to 5
Vigorish = 6.66%



Place 5
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.    Due to the payoff 
odds, you must be able to divide your bet amount evenly by 5 (5, 10, 15, 20, etc.).

Decision:
WINS if a 5 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 3 to 2
Payoff = 7 to 5
Vigorish = 4.00%



Place 6
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.    Due to the payoff 
odds, you must be able to divide your bet amount evenly by 6 (6, 12, 18, 24, etc.).

Decision:
WINS if a 6 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 6 to 5
Payoff = 7 to 6
Vigorish = 1.52%



Place 8
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.    Due to the payoff 
odds, you must be able to divide your bet amount evenly by 6 (6, 12, 18, 24, etc.).

Decision:
WINS if an 8 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 6 to 5
Payoff = 7 to 6
Vigorish = 1.52%



Place 9
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.    Due to the payoff 
odds, you must be able to divide your bet amount evenly by 5 (5, 10, 15, 20, etc.).

Decision:
WINS if a 9 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:

True odds = 3 to 2

Payoff = 7 to 5

Vigorish = 4.00%



Place 10
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.    Due to the payoff 
odds, you must be able to divide your bet amount evenly by 5 (5, 10, 15, 20, etc.).

Decision:

WINS if any combination of 10 is rolled.

LOSES if a 7 is rolled. 

If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 2 to 1
Payoff = 9 to 5
Vigorish = 6.66%



Buy 4
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.

However, the casino requires that you pay an additional charge of 5% of the bet amount at the time this bet 
is made (a $20 bet becomes a bet of $21).    This 5% charge MUST be paid regardless of whether the bet 
wins or loses.    In return, the casino will pay off your bet at true odds (it keeps the 5% charge).    The 5% 
charge must be in whole dollar amounts.

Decision:
WINS if a 4 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 2 to 1
Payoff = 2 to 1 (casino keeps 5% charge)
Vigorish = 4.76%



Buy 5
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.

However, the casino requires that you pay an additional charge of 5% of the bet amount at the time this bet 
is made (a $20 bet becomes a bet of $21).    This 5% charge MUST be paid regardless of whether the bet 
wins or loses.    In return, the casino will pay off your bet at true odds (it keeps the 5% charge).    The 5% 
charge must be in whole dollar amounts.

Decision:
WINS if a 5 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 3 to 2
Payoff = 3 to 2 (casino keeps 5% charge)
Vigorish = 4.76%



Buy 6
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.

However, the casino requires that you pay an additional charge of 5% of the bet amount at the time this bet 
is made (a $20 bet becomes a bet of $21).    This 5% charge MUST be paid regardless of whether the bet 
wins or loses.    In return, the casino will pay off your bet at true odds (it keeps the 5% charge).    The 5% 
charge must be in whole dollar amounts.

Decision:
WINS if a 6 is rolled.
LOSES if a 7 is rolled.
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 6 to 5
Payoff = 6 to 5 (casino keeps 5% charge)
Vigorish = 4.76%



Buy 8
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.

However, the casino requires that you pay an additional charge of 5% of the bet amount at the time this bet 
is made (a $20 bet becomes a bet of $21).    This 5% charge MUST be paid regardless of whether the bet 
wins or loses.    In return, the casino will pay off your bet at true odds (it keeps the 5% charge).    The 5% 
charge must be in whole dollar amounts.

Decision:
WINS if an 8 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 6 to 5
Payoff = 6 to 5 (casino keeps 5% charge)
Vigorish = 4.76%



Buy 9
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.

However, the casino requires that you pay an additional charge of 5% of the bet amount at the time this bet 
is made (a $20 bet becomes a bet of $21).    This 5% charge MUST be paid regardless of whether the bet 
wins or loses.    In return, the casino will pay off your bet at true odds (it keeps the 5% charge).    The 5% 
charge must be in whole dollar amounts.

Decision:
WINS if a 9 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 3 to 2
Payoff = 3 to 2 (casino keeps 5% charge)
Vigorish = 4.76%



Buy 10
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.

However, the casino requires that you pay an additional charge of 5% of the bet amount at the time this bet 
is made (a $20 bet becomes a bet of $21).    This 5% charge MUST be paid regardless of whether the bet 
wins or loses.    In return, the casino will pay off your bet at true odds (it keeps the 5% charge).    The 5% 
charge must be in whole dollar amounts.

Decision:
WINS if a 10 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 2 to 1
Payoff = 2 to 1 (casino keeps 5% charge)
Vigorish = 4.76%



Lay 4
Description:

This multiple-roll bet is the opposite of the Buy 4 and can be made and removed at any time during the 
game. 

However, the casino requires that you pay an additional charge at the time this bet is made.    This additional
charge is equal to 5% of the payoff.    (For example, a $40 Lay 4 bet has a payoff of 1 to 2 or $20.    5% of 
$20 = $1, so the bet amount becomes $40 + $1 = $41.)

This 5% charge MUST be paid regardless of whether the bet wins or loses.    In return, the casino will pay 
off your bet at true odds (it keeps the 5% charge).    The 5% charge must be in whole dollar amounts.

Decision:
WINS if a 7 is rolled.
LOSES if a 4 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 1 to 2
Payoff = 1 to 2 (casino keeps 5% charge)
Vigorish = 2.44%



Lay 5
Description:

This multiple-roll bet is the opposite of the Buy 4 and can be made and removed at any time during the 
game. 

However, the casino requires that you pay an additional charge at the time this bet is made.    This additional
charge is equal to 5% of the payoff.    (For example, a $30 Lay 5 bet has a payoff of 2 to 3 or $20.    5% of 
$20 = $1, so the bet amount becomes $30 + $1 = $31.)

This 5% charge MUST be paid regardless of whether the bet wins or loses.    In return, the casino will pay 
off your bet at true odds (it keeps the 5% charge).    The 5% charge must be in whole dollar amounts.

Decision:
WINS if a 7 is rolled.
LOSES if a 5 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 2 to 3
Payoff = 2 to 3 (casino keeps 5% charge)
Vigorish = 3.23%



Lay 6
Description:

This multiple-roll bet is the opposite of the Buy 4 and can be made and removed at any time during the 
game. 

However, the casino requires that you pay an additional charge at the time this bet is made.    This additional
charge is equal to 5% of the payoff.    (For example, a $24 Lay 6 bet has a payoff of 5 to 6 or $20.    5% of 
$20 = $1, so the bet amount becomes $24 + $1 = $25.)

This 5% charge MUST be paid regardless of whether the bet wins or loses.    In return, the casino will pay 
off your bet at true odds (it keeps the 5% charge).    The 5% charge must be in whole dollar amounts.

Decision:
WINS if a 7 is rolled.
LOSES if a 6 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 5 to 6
Payoff = 5 to 6 (casino keeps 5% charge)
Vigorish = 4.00%



Lay 8
Description:

This multiple-roll bet is the opposite of the Buy 4 and can be made and removed at any time during the 
game. 

However, the casino requires that you pay an additional charge at the time this bet is made.    This additional
charge is equal to 5% of the payoff.    (For example, a $24 Lay 8 bet has a payoff of 5 to 6 or $20.    5% of 
$20 = $1, so the bet amount becomes $24 + $1 = $25.)

This 5% charge MUST be paid regardless of whether the bet wins or loses.    In return, the casino will pay 
off your bet at true odds (it keeps the 5% charge).    The 5% charge must be in whole dollar amounts.

Decision:
WINS if a 7 is rolled.
LOSES if an 8 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 5 to 6
Payoff = 5 to 6 (casino keeps 5% charge)
Vigorish = 4.00%



Lay 9
Description:

This multiple-roll bet is the opposite of the Buy 4 and can be made and removed at any time during the 
game. 

However, the casino requires that you pay an additional charge at the time this bet is made.    This additional
charge is equal to 5% of the payoff.    (For example, a $30 Lay 9 bet has a payoff of 2 to 3 or $20.    5% of 
$20 = $1, so the bet amount becomes $30 + $1 = $31.)

This 5% charge MUST be paid regardless of whether the bet wins or loses.    In return, the casino will pay 
off your bet at true odds (it keeps the 5% charge).    The 5% charge must be in whole dollar amounts.

Decision:
WINS if a 7 is rolled.
LOSES if a 5 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 2 to 3
Payoff = 2 to 3 (casino keeps 5% charge)
Vigorish = 3.23%



Lay 10
Description:

This multiple-roll bet is the opposite of the Buy 4 and can be made and removed at any time during the 
game. 

However, the casino requires that you pay an additional charge at the time this bet is made.    This additional
charge is equal to 5% of the payoff.    (For example, a $40 Lay 10 bet has a payoff of 1 to 2 or $20.    5% of 
$20 = $1, so the bet amount becomes $40 + $1 = $41.)

This 5% charge MUST be paid regardless of whether the bet wins or loses.    In return, the casino will pay 
off your bet at true odds (it keeps the 5% charge).    The 5% charge must be in whole dollar amounts.

Decision:
WINS if a 7 is rolled.
LOSES if a 4 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 1 to 2
Payoff = 1 to 2 (casino keeps 5% charge)
Vigorish = 2.44%



Field
Description:

This is a one-roll bet and can be made at any time during the game.    The payoff depends on settings in the 
"Set Up Casino" window (to access this window, select "Options" and then "Casino").

Decision:
WINS if a 2, 3, 4, 9, 10, 11 or 12 is rolled.
LOSES if a 5, 6, 7 or 8 is rolled.

Payoff -- (Field 2 Pays = "Double" and Field 12 Pays = "Double"):
Payoff = 2 to 1      (if 2 or 12 is rolled).
Payoff = 1 to 1      (if 3, 4, 9, 10 or 11 is rolled).
Vigorish = 5.55%.

Payoff -- (Field 2 Pays = "Double" and Field 12 Pays = "Triple"):
Payoff = 2 to 1      (if a 2 is rolled).
Payoff = 3 to 1      (if a 12 is rolled).
Payoff = 1 to 1      (if a 3, 4, 9, 10 or 11 is rolled).
Vigorish = 2.77%



Big 6
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.

Decision:
WINS if a 6 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 6 to 5
Payoff = 1 to 1
Vigorish = 9.09%



Big 8
Description:

This is a multiple-roll bet and can be made and removed at any time during the game.

Decision:
WINS if a 8 is rolled.
LOSES if a 7 is rolled. 
If any other combination is rolled, no decision is made and the dice are rolled again.

Payoff:
True odds = 6 to 5
Payoff = 1 to 1
Vigorish = 9.09%



Overdraft Warning
This message warns you when your strategy attempts to make a bet that exceeds your chips in the Bankroll 
Rail.    Choose one of the options provided and click OK.



Marker Dialog
This dialog box allows you to "borrow" money to cover a bet that exceeds your chips in the Bankroll Rail.   
Choose one of the options provided and click OK.



Free Odds
Choosing Setup Strategy...Bets from the StrategyMaster menu will display the Betting Strategy dialog 
box.    Select the check box next to the type of bet you want that has Free Odds (i.e. Pass, Don't Pass, Come 
or Don't Come).    The Make A Bet dialog box will appear.    Click on the Free Odds button to display the 
Free Odds dialog box.

You have great flexibility in setting up your free odds bets when making a Pass, Don't Pass, Come or Don't 
Come bets.    For each established Point. there are five selections to choose from:

1) No odds - No free odds bets will be made
2) Single odds - StrategyMaster will automatically calculates your single odds bet.
3) Double odds - StrategyMaster will automatically calculates your double odds bet.
4) Triple odds - StrategyMaster will automatically calculates your triple odds bet.
5) Custom odds - You manually type in any free odds amount you want.



Ordering CASINO PLANNER
Order CASINO PLANNER for Craps within two weeks to receive additional $5 
discount off the low sale price of $34.95*, regularly $59.95.

***      FREE video included!!!      ***
Also, visit our home page at http:\\igsware.com for latest information about IGS and
Casino Planner, as well as, other cool casino sites.
*Add $4.95 shipping and handling.    Florida Residents add 6% sales tax.

Credit Card Orders

Check or Moneyorder

About CASINO PLANNER™ for Craps...

CASINO PLANNER™ for Craps Features



Credit Card Orders
Mastercard and VISA only.
Monday - Saturday, 9 AM - 8 PM    EST
INSIDE THE USA
Call 1-800-KEY-2-WIN
(that's 1-800-539-2946)
OUTSIDE THE USA
Call (407) 826-4817



Check or Moneyorder
International Gambling Software, Inc.
12319 S. OBT, Suite 261
Orlando, FL    32837 



About CASINO PLANNER™ for Craps...
CASINO PLANNER is an advanced interactive multimedia game and powerful application.    This software
marks the beginning of a new era in gambling    in which players for the first time can use their home 
personal computer to prepare for a trip to the casino and thus dramatically increase their chances of 
winning.    This software breakthrough was achieved by using many exclusive features not found in any 
other product.

CASINO PLANNER is introducing a new standard called the WinRating™.    The WinRating allows you to
know what your chances are of winning in terms of percent before stepping up to the tables and without 
risking your hard-earned bankroll.    If you are willing to put a greater amount of money at risk than you are
to win then you can actually have a WinRating of greater than 50%.    The significance of this is that even 
though nobody is guaranteed to win, the WinRating allows you    to know in advance what your chances of 
winning are and you can have the advantage of winning over the casino for a given session at the table.

CASINO PLANNER has powerful capabilities not found in any other software on the market today.

For a given strategy, you will:
· Learn advantages and disadvantages about your strategy.
· Learn what your chances of winning are in terms of percent. (WinRating™)
· Learn how to determine a realistic WinGoal.
· Learn what the chances are of reaching your Win Goal. (WinGoal Rating™)
· Learn how much bankroll is needed to play your strategy.
· Learn how much Playtime you can expect from your strategy.
· Learn what the expected "cost per hour" is to play your strategy.
· Learn what the House Advantage is for your strategy. (VigRating™)
· Learn when the best time is to stop playing to maximize your winnings.
· Learn how to have WinRatings of greater than 50%.

You will:
· Objectively compare crap strategies in the matter of minutes.
· Create and save your own strategies
· Print your results or export to other programs to create graphs and charts
· Learn how to get vigs as low as 0.275%
· Learn how to play for a minimum amount of time(i.e. 4, 8 12 hours), this is ideal for Junket 

Players.

CASINO PLANNER:
· Provides you with over 50 of the best-known strategies
· Automatically notifies and adjusts any incorrect bet amounts
· Allows for all bet types (including Free odds, Buy and Lay bets)
· Allows you to customize payoff odds to match your favorite casinos. Many of the most popular 

casino's are provided with the software.
· User-friendly interface

"The Best Strategy For Winning Is PREPARATION!"
International Gambling Software, Inc.; 12319 S. Orange Blossom Trail, Suite 261; Orlando, FL 32837    (407)826-4817



CASINO PLANNER for Craps Features
· Craps Tutor teaches people new to the game to how to play.
· StrategyMaster teaches advanced players to how to win.
· There are two modes of operation:

1. Game Mode

2. StrategyMaster mode
· Sound options include: 

1. Dealer's voice heard just like at a real crap table!

2. Sound effects (dice, bets being placed or removed, etc...)

3. Jukebox style Music (preloaded or use your own MIDI sound files or use CD music disc)

4. Casino crowd sounds
· Custom strategies can be saved and retrieved
· Different casinos can be saved and retrieved
· Strategy Results Options include: 

1. Overall

2. Each session

3. Bankroll graph

4. Shooter stats
· Hot / Cool table indicator
· Player and stickman animation at the table
· 12 animated players to choose from, each with their own personality and mannerisms
· Dice pass from one player to another after shooter seven's out
· Multimedia PC (MPC) compatible
· User friendly online help 
· 256 color graphics

Exclusive features include:
· StrategyMaster - A powerful tool that lets the you test crap strategies in the matter of minutes.
· Money Management Assistant - Automatically determines a realistic WinGoal and required 

bankroll for a given strategy.
· Bet Sequencer - Allows    bets to automatically be increased or decreased.
· Fundamental Five for a given strategy:

1. WinRating - What your chances are of winning

2. WinGoal Rating - What your chances are of reaching your Win Goal

3. Average Playtime at table - Expected playtime at the table

4. Average Net when leaving table - Expected Win / Loss at the table

5. VigRating - House advantage for entire strategy
The Fundamental Five -- "Don't Play at the Casino Without It!"

International Gambling Software, Inc.; 12319 S. Orange Blossom Trail, Suite 261; Orlando, FL 32837    (407)826-4817



Shortcuts
It is strongly recommended to FIRST read the entire manual before using CASINO PLANNER for Craps.   
However, for those of you who want to get started right away, the following describes the minimum you 
need to know to use the software.

Related Topics:
How to Play Craps
Crap Table
Unlabeled Bets on the Table
Benefits of the Gray Table
Instant Help on All Crap Bets
Game Mode
How to Make a Bet
How to Remove a Bet
How to Roll the Dice
StrategyMaster Mode



How to Play Craps
The Comeout roll is the first roll of a new game. This is signified by a round puck facing black side up and 
is positioned off to the side of the main layout of the table.    If a Comeout roll is 7,11,2,3, or 12 then the 
"game" is over and the next Comeout roll begins a new game . On a Comeout roll if a 4,5,6,8,9, or 10 is 
rolled, a Point number is established and the puck is moved on top of the Point number with the white side 
facing up. 

DEFINITION:    Comeout roll.    The Comeout roll is always the FIRST roll of a new 
craps game and is signified by a round puck facing black side up and is positioned off to 
the side of the table.

When a Point is established, the Comeout roll is over and it is now a Point roll.    It remains a Point roll as 
the dice are rolled again and again until either the Point number is repeated or a 7 is rolled.    If any of these 
two events occurs, the game is over and a new game starts again with the Comeout roll. 

DEFINITION:    Point roll.    Any roll AFTER the first roll of a new game (i.e. first roll is 
Comeout roll) and is signified by a round puck facing white side up and is positioned on 
the Point number established from the Comeout roll.

The following flow diagram summarizes how simple it is to play craps.    Notice how the game of craps is 
played independent of any bets on the crap table.    

There are over forty bet options that can be made, but as a player, you only need to play one bet.    It is, 
however, common to see players using multiple bets during the course of a game.    

RULE:    There are over forty different bets to choose from in the game of craps.    For 
each crap game, your are only required to play at least one bet (or a combination of bets) 
that meets the table bet minimum, typically $5.    

RECOMMENDATION:    If you are a beginner, it is strongly recommended that you only
focus on the Pass Line bet.    Once you master the Pass Line bet, you will be ready to 
explore other bet options.    

The Pass Line bet is without question the most popular crap bet and it has one of the lowest vigs (house 
advantage) in the entire casino.    Therefore if you are a beginner, you should master the Pass Line bet 
before learning other bets.    Once you are ready to learn about other bet options, choose Contents under the
Help menu and see heading titled Crap Bets.



Crap Table
The IGS crap table has the authentic layout of a real casino crap table.    However, only one half of the IGS 
crap table is visible since the other half is a mirror image of the first half.    Also, you will see how to play at
the crap table with other animated players -- each with their own personality.

RECOMMENDATION:    If the IGS crap table colors look a little dark, adjust the 
brightness knob on your monitor appropriately.    Also, 256 colors will look much better 
than 16 colors. 



Unlabeled Bets on the Table
Unfortunately, a real crap table only has some of the bets labeled with text on the layout.    Bets that don't 
have text    include, Place bets, Buy bets, Lay bets, Come and associated Free Odds bet, as well as, Don't 
Come bets and associated Free Odds bets.    That's seven type of bets with that do not have a label on a real 
crap layout.    For the IGS crap table, the following diagram shows areas where to click with the mouse 
button to make various bets that are not labeled on the table.

For a given bet type, only one example was given in the table.    For example, there are six different Place 
bets on the Table (i.e. Place 4, 5, 6, 8, 9 and 10).    Only the area where to make a Place 10 is shown in the 
above diagram, other Place bets are made in a similar manner.    Notice the Place bet area covers the left 
most 50% area of where the 10 is marked on the table.    The right most 50% area is for the Buy 10 bet.    
The other 5 numbers (i.e. 4, 5, 6, 8 and 9) follow the same convention for Place and Buy bets.    The gray 
crap table distinguishes the "unlabeled" bets by using two different shades of gray. 



Benefits of the Gray Table
From the Options menu, choose Casino.    In the lower left side of the dialog, select the gray table and 
click OK.    Now you will see a gray crap table.    Notice there are light gray and dark gray areas on the 
layout.    These different shadings of gray distinguish unlabeled bets and show    where one bet area starts 
and another begins.    Placing unlabeled bets is therefore more intuitive with the gray table.    Also, the gray 
table makes it easier to see the colored chips resting on the table.    For these reasons, you may want to    
play with the gray table most of the time. 



Instant Help on All Crap Bets
There are times when you are interested in the certain aspects of a particular bet (i.e. you forgot payoff 
odds).    Help for all the bets on the IGS crap table is just a mouse click away.    

RECOMMENDATION:    Hold down the SHIFT key and click with the left mouse button
on the IGS crap table for instant On-line Help for the bet you are interested in.

Help information on a specific crap bet includes definition, true odds, payoff odds, house advantage, 
decision, and vigorish.    When you are done with the help, go to the File menu and choose Exit.

RECOMMENDATION:    While using the On-line Help, hold the ALT key and then press
the TAB key to "toggle" you back and forth between On-line Help and the IGS crap table.



Game Mode
When using CASINO PLANNER, you can be in one of two modes -- Game Mode or StrategyMaster 
Mode.    You can change from one mode to the other at any time, but this will cause a reset.    From the 
Options menu, select Mode to change setting.    The current mode of CASINO PLANNER is always 
displayed in the Control Panel located below the IGS crap table.

DEFINITION:    Game Mode.    All bets must be made manually, one roll at a time, just 
like you would in a real casino

This mode allows you to practice playing a strategy after you have found one you liked from the 
StrategyMaster mode.    Therefore, you can play on your own as if you were at a real crap table for the 
benefit of preparing for a trip to a real casino.



How to Make a Bet
To make a bet in a real casino you would take chips out of your bankroll, assembling them in your hand, 
until you have the amount you want.    Then you would put those chips on the table.    This method is very 
similar with CASINO PLANNER except that you must use the bet rail, not your hand, to assemble your bet
before putting it on the table. 

How to take chips out of your Bankroll Rail and assemble them in the Bet Rail:

1. To add chips to the Bet Rail, use the left mouse button and click on the chip color in the Bankroll Rail 
that you would like to add to the Bet Rail.    Each time you click the mouse on a chip color, it will be 
added to the Bet Rail.

2. To remove a chip from the Bet Rail, use the right mouse button and click on the chip color in the 
Bankroll Rail that you would like to remove from the Bet Rail.    Each time you click the mouse on a 
chip color in the Bankroll Rail, it will be removed from the Bet Rail.

3. To remove all chips from the Bet Rail, use the left or right mouse button and click anywhere in the 
empty space just to the right of the chips in the Bankroll Rail. 

4. An alternate way to assemble a bet in the Bet Rail is to highlight the Bet Rail amount which is 
represented by a number and directly type in the bet amount desired, then hit the TAB key.

For example, let's make a $25 Pass Line bet.

5. Make a $25 "Pass Line" bet by moving the cursor (hand)    so that the "index finger" is over the upper 
50% of the Pass Line area on the table and click with the left mouse button.    You now have a $25 Pass 
Line bet on the table.

Use this same procedure to make bets anywhere on the IGS crap table.

RULE:    Use the left mouse button to manually make a bet on the IGS 
crap table.



How to Remove a Bet
To remove a bet on the IGS crap table simply move the cursor (hand) over the bet and click with the right 
mouse button.    Try this by moving the cursor over the $25 Pass Line bet and then click with the right 
mouse button.    Now the bet is removed.    Move the cursor over the Pass Line area and click with the left 
mouse button.    The $25 in the Bet Rail will now be on the Pass Line.

RULE:    Use the right mouse button to 
remove a bet.



 How to Roll the Dice
Now that that we have a $25 Field bet on the table, we are ready to roll the dice.    A pair of red dice can be 
found on the left side of the IGS crap table.    There are three different ways to manually roll the dice.

1. Click on the one of the two dice  with the left mouse button for a random roll. 
2. Click on the one of the two dice with the right mouse button.    A dialog box will pop up as shown below.    

Enter the dice number you want for the next roll.    When you click OK the dice will be rolled with 
the number you have intructed.

3. Click on the "Roll Dice"  button located in the Control Panel for a random roll.



StrategyMaster Mode
When using CASINO PLANNER, you can be in one of two modes -- Game Mode or StrategyMaster 
Mode.    You can change from one mode to the other at any time, but this will cause a reset.    From the 
Options menu, select Mode to change setting.    The current mode of CASINO PLANNER is always 
displayed in the Control Panel located below the IGS crap table.

DEFINITION:    StrategyMaster Mode.    All bets are made automatically according to a 
predefined Betting Strategy that has been entered through the convenient "Make A Bet" 
window.

In the StrategyMaster Mode,    CASINO PLANNER will automatically make ALL your bets as defined by a
Betting Strategy that is saved in memory.    StrategyMaster can simulate up to 20,000 consecutive sessions 
in a short period of time.    After a simulation is completed, StrategyMaster will tally the results and provide
you a wide range of important information about your Strategy.    With this information you will be able to 
"fine tune" your Strategy for optimum performance (i.e. WinRating, Playtime, cost, etc.), or objectively 
compare it to other strategies.

For more information on StrategyMaster, read the "StrategyMaster Mode" section of the manual or on-line 
help.



 Appendix A - How to Use the Bet Sequencer
RECOMMENDATION:    The Bet Sequencer is an advanced feature of CASINO 
PLANNER.    It is not recommended to use this feature until you are comfortable using 
"fixed bets" with StrategyMaster.

Some of the most famous crap strategies are based on a sequence of bets.    In other words, a particular bet 
will be increased or decreased depending on whether the bet has just won or lost.    The Bet Sequencer may 
be used with any bet on the IGS crap table.    

To use the Bet Sequencer, you must first bring up a "Make-A-Bet" window.    For this example, lets bring 
up the Field "Make-A-Bet" window.    Move the cursor over the IGS crap table, hold down the CNTRL key 
and click with the left mouse button on top of the Field bet area of the table.    The "Make A Bet on the 
Field" window will appear as shown below. 

Click on the Bet Sequencer  button.    The "Edit a Betting Sequence" dialog box 
will appear as shown below:

{ewc D2HTools, D2H_256Color, help0069.bmp}

Rules for Using the Bet Sequencer
There is two rules that must be followed when using the Bet Sequencer.    

1. Both the "IF I WIN" and "IF I LOSE" sequences MUST end with a box that contains the letter R 
followed by a box that contains a "repeat number".    

2. A bet entry of "Zero" ($0) is not allowed anywhere in the sequence.    

The two sequences, whether they are used or not, must end in R followed by a number.    R followed by 1 
means repeat the last bet.    R followed by 2 means repeat the last two bets and so on.    The letter R simply 
tells StrategyMaster where to go for the next bet when it reaches the end of a bet sequence.    Any entry 
after R and the "repeat number" will be ignored.

Initial Bet
The "Initial Bet" box shows the amount of the first bet in the sequence.    This amount is also be shown in 
the "Make A Bet" window. 

IF I WIN Sequence



Use the "IF I WIN" sequence boxes to increase or decrease your bets when you are winning.    If a bet loses 
in the middle of the win sequence then the sequence starts back over at the "Initial Bet" amount.    The win 
sequence is useful for setting up such systems as the Anti-Martingale and Paroli (or Great Paroli) and also 
for press bets.    

If I LOSE Sequence
Use the "IF I LOSE" sequence boxes to increase or decrease your bets when you are winning.    If a bet 
wins in the middle of the lose sequence then the sequence starts back over at the "Initial Bet" amount.    The
lose sequence is useful for setting up such systems as Martingale, Grand Martingale (Rothstein), Short-
Leash Grand Martingale (Short-Leash Rothstein), and the Field System (using sequenced betting). 

Bet Sequencer Example #1
Let's see how to setup the Bet Sequencer for a system that is similar to Martingale.    The basic idea behind 
Martingale systems is to start out with an initial bet and stay at that amount as long as you are winning.    
Each time your bet loses, you double your bet until the bet wins, at which time the bet is starts over again at
the initial amount.    

For this example, we will setup a strategy that has an initial bet of $5 on the Field.    Each time this Field bet
WINS, the bet will remain at $5.    Each time this Field bet LOSES, the next bet will be double the previous
amount.    When the bet reaches $40, the strategy will return back to its initial bet amount of $5.    The "Edit 
a Betting Sequence" dialog box below shows how this sequence should be entered.

{ewc D2HTools, D2H_256Color, help0070.bmp}

This dialog box interacts StrategyMaster start out with an initial bet of $5 on the Field bet.    Let's say the 
first roll is 3 and therefore the bet wins.    The Bet Sequencer will then enter the "IF I WIN" sequence.    The
first box this sequence contains the letter R.    Therefore, StrategyMaster will look at the next box 
immediately after the R to see how many bets to "Repeat".    In this case, the R is followed by a "1".    This 
means StrategyMaster will go back and "Repeat" the last bet, in this case that would be the Initial Bet, $5.    
Now StrategyMaster is back at the Initial Bet for the next roll.

Let's say the second roll is a 7 and therefore the bet loses.    The Bet Sequencer will then go from the Initial 
Bet and enter the "IF I LOSE" sequence.    The first box of this sequence contains a bet amount of $10.    
Therefore, StrategyMaster will increase your Field bet from $5 to $10 for the next roll.    Now 
StrategyMaster is at the first box in the "IF I LOSE" sequence. 

Let's say the third roll is a 6 and therefore the bet loses again.    The Bet Sequencer will then go from the 
first box in the "IF I LOSE" sequence to the second box in the "IF I LOSE" sequence.    The second box of 
this sequence contains a bet amount of $20.    Therefore, StrategyMaster will increase your Field bet from 
$10 to $20 for the next roll.    Now StrategyMaster is at the second box in the "IF I LOSE" sequence.

Let's say the fourth roll is a 8 and therefore the bet loses again.    The Bet Sequencer will then go from the 
second box in the "IF I LOSE" sequence to the third box in the "IF I LOSE" sequence.    The third box of 
this sequence contains a bet amount of $40.    Therefore, StrategyMaster will increase your Field bet from 
$20 to $40 for the next roll.    Now StrategyMaster is at the third box in the "IF I LOSE" sequence.

Let's say the fifth roll is a 8 and therefore the bet loses again.    The Bet Sequencer will then go from the 
third box in the "IF I LOSE" sequence to the fourth box in the "IF I LOSE" sequence.    The fourth box of 
this sequence contains the letter R.    Therefore, StrategyMaster will look at the box immediately after the R
to see how many bets to "Repeat".    In this case, the R is followed by a "4".    This means StrategyMaster 
will go back and "Repeat" the last four bets.    In this case, that would mean going back past the $40, past 
the $20, past the $10 and stopping at $5, which happens to be the Initial Bet.    Therefore, StrategyMaster 
will decrease your Field bet from $40 to $5 for your next bet.    Now StrategyMaster is back at the Initial 
Bet for the next roll.

If you lose a the sixth roll, your next bet will be $10 but if you win on the sixth roll, your next bet will go 
back to the Initial Bet of $5 because the "IF I WIN" sequence is R followed by 1 (repeat last bet).    
StrategyMaster is following exactly how the strategy was defined.



Bet Sequencer Example #2
In this next example, let's say you have a strategy that evolves pressing your Place 8 bet when it wins.    
This strategy will start out with an initial bet of $6.    After your first hit (win) you want the same bet of $6.  
After your second hit (win) you want to press your bet to $12.    After your third hit (win) ) you want the 
same bet of $12.    After your fourth hit (win) you want to press your bet to $24 and so on.

Therefore, the betting sequence is "same bet", "press", "same bet", "press", "same bet", "press", etc.    The 
"Edit a Betting Sequence" dialog box below shows how this sequence should be entered

Bet Sequencer Example #3
In this next example, let's say you have a strategy that evolves a different pressing method for your Place 8 bet when
it wins.    This strategy will start out with an initial bet of $6.    After your first hit (win) you want to press your bet to 
$12.    After your second hit (win) you want to press your bet again to $18.    After your third hit (win) you want to 
press your bet again to $24.    After your fourth hit (win) you want to press your bet again to $30 and then stay at this
amount until the bet loses.    

Therefore, the betting sequence is $6, $12, $18, $24, $30 and then stay at $30 until bet loses.    The "Edit a 
Betting Sequence" dialog box below shows how this sequence should be entered.



Bet Sequencer Example #4
In this next example, let's say you have a strategy that evolves a different pressing method but this time on    the 
Place 5.    This strategy will start out with an initial bet of $10 on the Place 5.    After your first hit (win) you stay at 
$10,    after your second hit (win) you press your bet to $20.    After your third hit (win) you decrease your bet back 
to 10.    After your forth hit (win) you want to press to $20 again and so.    

This pattern is followed ($10, $10, $20, $10, $20, etc.) until the bet loses.    The "Edit a Betting Sequence" 
dialog box below shows how this sequence should be entered.



Summary
The Bet Sequencer has allot of flexibility and is easy to setup.    These examples were meant to show you the basics 
of the Bet Sequencer.    It's up to you to come up with your own ideas and betting patterns.    After running 
StrategyMaster, refer to the Overall Results window (located under the StrategyMaster menu) to clearly see what 
works and what doesn't work when it comes to pressing Place bets, as well as, other types of betting sequences.



Appendix B - How to Adjust "Accuracy of Results"
StrategyMaster is based on Monty Carlo simulations to give you reliable results about your strategy.    Since
StrategyMaster is based on a simulation, it is possible for you to control how accurate the results will be.    
In other words, the longer a simulation run, the more accurate the results will be.    However, more accurate 
results means more waiting on your part for the simulation to complete.    Therefore, there has to be some 
middle ground on how long the simulation run should be versus how accurate the results will be.

A typical Results window which contains the information from a StrategyMaster run is shown below:

Related Topics:
Five-Star Rating
Determining the "Number of Sessions per Run



Five-Star Rating
CASINO PLANNER uses the commonly known    Five-Star Rating to help indicate the accuracy of the 
results.    The more hours per simulation, the more accurate the results will be.    Therefore, as a guide to 
help you quickly understand the accuracy of the results, CASINO PLANNER has defined the Five-Star 
Rating as shown below:

* => "Rough Estimate" 0 - 100 Total PLAYTIME hours
** => "Fair" 100-750 Total PLAYTIME hours
*** => "Good" 750 - 5,000 Total PLAYTIME hours
**** => "Very Good" 5,000 - 40,000 Total PLAYTIME hours
***** => "Excellent" 40,000 + Total PLAYTIME hours

OBSERVATION:    The Five-Star Rating is dependent soly on Total 
PLAYTIME.



Determining the "Number of Sessions per Run
As you can see, the Five-Star Rating is directly tied into the total number of PLAYTIME hours for a 
StrategyMaster run.    IGS recommends to look at results that have at least a rating of "three-stars" (i.e. 
Good).    There is only one value that you can use to control the "Total PLAYTIME" hours for a 
StrategyMaster run.    This control is called "Number of Sessions per Run".    From the Options menu, 
choose StrategyMaster.    The "StrategyMaster Options" dialog box will appear as shown below:

The default value for the "Number of Sessions per Run" is 1000.    This will probably be sufficient for most 
strategies to have a rating of at least "three stars".    If you do not get at least a rating of "three-stars" or you 
would like to get a higher rating, you can determine the right value for the "Number of sessions per Run":

Number of Sessions per Run (min.) =    Desired Total PLAYTIME hours

Avg. PLAYTIME (from previous Fundamental Five results)

SHORTCUT:    If you're not into math, you can estimate the "Number of Sessions per 
Run" by simply entering a value that equals the desired "Total PLAYTIME":

Number of Sessions per Run (estimate)
=

Desired Total PLAYTIME hours

Appendix C - Vig, VigRating and NET-per-Hour
Vigorish
VigRating
Entertainment Value and "NET-per-Hour"



Vigorish
The vigorish is a term that every player should be familiar with, but unfortunately most players don't 
understand its significance.    Furthermore, it's amazing how many people go to the casino and expect to 
win -- without knowing anything about this enigmatic term.    So, what in the world is the "vig" anyway and
why is it so important?    

DEFINITION: Vigorish.    The vigorish, or vig for short, is the advantage that the casino 
has over the player for each individual bet on the crap table.    It is a measure of how fast 
you can expect to lose your money based on the total amount of money wagered on a 
specific crap bet.

The Vigorish is an indicator of how fast a player can lose his money.    Vigorish, or "vig," is the commission
the casino charges for each bet.    This is the only way in which they make their profits.    The term 
"Vigorish" is an older expression that is not used much in casinos today.    But, it is often referred to in 
many other ways -- "advantage", "house advantage", "casino advantage", "commission", "edge", "the house
edge", "percentage", "house percentage", or simply the "PC".

The vig is expressed as a percentage.    For example, the Pass Line bet has a vig of 1.41%.    This means that
for every $100 you bet on the Pass Line, the casino will keep an average of $1.41.    This does not mean 
that you have to fork over $1.41 every time you make a $100 bet.    It does mean that, over time, this bet 
will give the casino a 1.41% cut of the all money made on this bet.    This money comes out of your 
winnings, not out of your losses.    In the game of craps, each individual bet has its own vig.    Remember,

"The higher the vig, the
more you GIVE."



VigRating
The Vig (or House Advantage) is well published for each of the individual bets on the table, but what about 
a combination of different bets as defined in a Betting Strategy?    This is the way most people play.    The 
answer is the VigRating.    The VigRating plays a very important role in helping you choose the right 
Betting Strategy before you go to the casino.

DEFINITION: VigRating.    The VigRating is the advantage that the casino has over the 
player for an entire Betting Strategy.    It is a measure of how fast you can expect to lose 
your money based on the total amount of money bet while playing a certain Betting 
Strategy.

 RECOMMENDATION:    Use the VigRating as a secondary factor, to the NET-per-Hour,
for objectively comparing Betting Strategies.

Even though the VigRating applies to multiple bet strategies, it should be thought of in the same way as the 
vig for an individual bet.    For example, a VigRating of 5% means that for every $100 you bet while 
playing a Betting Strategy, the casino will keep an average of $5.    

How do you know what is a reasonable vig and what isn't?    The answer is simple.    Think of the vig is a 
kind of tax, and, just like a sales tax, a reasonable VigRating for a strategy would be a value around 5% or 
less (the lower, the better).    You should beware of strategies with VigRatings much higher than this.    
Remember,

 "You can lose BIG if you don't
know the vig."



Entertainment Value and "NET-per-Hour"
Also, NET-per-Hour allows you become a "comparison shopper" by giving you the "cost" of different 
strategies.    As a smart shopper, would you go into a department store and buy an item without first 
knowing the price?    If two department stores had the same identical item but at two different prices, 
wouldn't you buy the item with the lowest price?    Likewise, a smart player will look at the NET-per-Hour 
(cost) for each strategy before making a decision whether or not to use that strategy at a casino.    Once you 
know the NET-per-Hour, you can choose a strategy that has a low expected cost, and therefore the best 
Entertainment Value.



Appendix D - Understanding "Maximum" Double Odds
The casino doesn't like certain free odds bets because they slow the pace of the game.    As the pace slows, 
so do the casino's profits.    The casino offers a solution that is advantageous for both you and the casino 

To illustrate, let's look at a $15 Pass Line bet with $30 double odds in the table at left.
The payoff for this bet is $36 which means the dealer must give you a $25 chip, two 
5$ chips, and a $1 chip.    Using multiple chips colors is undesirable to the casino as 
it slows the pace of the game, and most don't like payoffs that include $1 chips.    As 
a result, they often bend the rules a bit by allowing you to increase your free odds bet
to make the payoff jump to the next level ($48) in order to make the payoff more 
convenient.
However, a $48 payoff still uses $1 chips (and it still requires three chip colors).      
The next level above a $48 payoff is $60, which is what the casino is looking for -- 
an even payoff.    As a result, the casino will allow you to take $50 double odds    
instead of $30 double odds with your $15 Pass Line Bet.
This method of making your double odds bet higher than the "standard" double odds 
amount is called making a maximum double odds bet.
It's important to understand that there are no hard or fast rules that EVERY casino 
follows.    For a specific bet amount and Point number you need only ask the dealer 
what the "maximum" double odds bet is.    Individual casinos tend to be consistent 
from day-to-day about "maximum" double odds amounts.    Therefore, once you find 
a casino that allows you to increase your double odds bet in this manner, you will not
have to ask again the next time you visit that casino.
Notice that a casino that allows a $10 double odds bet to be increased to $25 will 
likewise allow a $100 double odds bet to be increased to $250 (the only difference 
being a factor of 10).    Although one casino might allow a $60 double odds bet to be 
increased to $125, another might allow the same bet to be increased to $200.    This 
depends on the casino you are visiting, and all you have to do is ask.
If you are a green chip player (making $25 bets on the Pass Line), when the Point is 
"6", you would take "standard" double odds of $50 for a payoff of $60.    With 
"maximum" double odds, you can achieve the same double odds payoff of $60 using 
a lower bet of $15 on the Pass Line.    This move lowers your vig from 0.61% to 
0.44% and equates to a savings of $280 over 1980 dice rolls!    Not a bad move.
If you are a Don't better, you can use the same tables used for the Pass bet.    For 
example, a $15 Don't Pass bet can lay maximum double free odds of $60 to win $50. 
Or, a $50 Don't Pass bet can lay maximum double free odds of $150 to win $125, and
so on.

Increasing your double odds bet in certain situations is good for both you and the casino.    Don't be shy to 
ask the Dealer in situations where you think they might give you "maximum" double odds -- after all, they 
want you to make this move more than you.    It casino keeps the game at a fast pace and you get a higher 
double odds bet and a lower vig.    However, make sure you have a large enough bankroll to play these 
higher odds bets.    You can use StrategyMaster to find out if you can afford to play this way or not.

To make maximum double odds bets using StrategyMaster, select the "custom" option in the "Free Odds" 
window.    Then, manually type in any double odds amount you want.    Note that the Point numbers 4 and 
10 NEVER have "maximum" double odds.    This is because the payoff is 2 to 1 (or 1 to 2) and the 
"maximum" situation of three chip colors or $1 chips does not apply.    Use the tables that follow only as a 
guide to help you understand the concept of maximum double odds and where it might be allowed.    

Maximum Double Odds, Point = 6 or 8



Maximum Double Odds, Point = 5 or 9





Appendix E - Misc. Tables
Dice Combinations
Payoffs for Crap Bets
Vigs for Crap Bets
Free Odds for Pass Line and Come
Free Odds for Don't Pass and Don't Come



Dice Combinations



Payoffs for Crap Bets



Vigs for Crap Bets
The following table shows vigs (house advantage) for all of the bets on the table, in order from lowest to 
highest vig.



Free Odds for Pass Line and Come



Free Odds for Don't Pass and Don't Come




